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Introduction 
This document is intended for use with Forensic Advantage®. Forensic Advantage® is a product 
with integrated features for case management and reporting. This document explains how to 
use Forensic Advantage® to create, view, edit, assign and collaborate on cases within a 
laboratory. To use this guide, you should be familiar with Microsoft Windows, Office and Web 
Based tools. 

ABBREVIATIONS 

Please see the table below for abbreviations used throughout this guide.  

Table 1 – Abbreviations 
Abbreviation Description 

TCSC The Computer Solution Company 

FA Forensic Advantage® 

FAS Forensic Advantage® Systems 

CL Crime Lab 

CNI Central Name Index 

PDF Portable Document Format 

RFLE Request for laboratory examination 

WBS Work Breakdown Schedule 

ZIP Compressed File 

e.g. Abbreviation meaning “for example” 

NOTATION CONVENTIONS 

The following fonts, symbols, and style conventions are used throughout this guide. 

Table 2 – Notation Conventions 
Notation Description Example 

Bold Action buttons Cancel, Open File 

Italics Screen, pane or 
module names 

Submission Details, Evidence module 

Bold and Italics Keys on keyboard 
or notes 

Tab, Enter, Note: Pay close attention 

Blue Underlined Active links See tcsc.com for more information. 

Bold with > 
separators 

Menu navigation Select Document > New > Template from the 
File menu. 
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THREE PANE VIEW 

Forensic Advantage is a feature-rich application that provides a dynamic view of its contents. 
The system leverages an interface paradigm called the three pane view. The primary 
components of the user interface are the Navigation Pane, Contents Pane and Notifications 
Pane. 

 
Figure 1 – Case Processing My Work View 

NAVIGATION PANE 
The Navigation Pane provides a functional directory and is used to select high level categories 
within the application. 

CONTENTS PANE 
The Contents Pane populates the relevant data from the selection made in the Navigation Pane. 
Double-clicking a row in the Contents Pane typically displays a window with additional 
information or functions related to that entry. The Contents Pane can be customized per user 
(see Customizing Your Workspace). 

NOTIFICATIONS PANE 
The Notifications Pane displays any notifications for the current user logged in to the system. 
System Notifications allow FA to notify users when certain actions occur by other users on the 
system. See User Settings for information on managing notifications.  
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THE RIBBON 

The Ribbon allows for easy navigation and access to the available menu options. Each set of 
actions is grouped together into a section grouping or ribbon tab. Clicking an icon results in the 
same action as selecting a drop-down menu option. 

 
Figure 2 – New Submissions Ribbon 

Table 3 – New Submissions View Ribbon Options 
Grouping Option Effect 

File 

New Opens New-Submission Entry form to start a new 
submission. 

Open Opens Submission Details form to view or modify 
details of the selected submission. 

Content Refresh Updates the Contents Pane with any new entries. 

Cases 

Case Details Opens Case Details form for the selected 
submission. 

Reserve Lab # Opens Reserve Lab # dialog to reserve a Lab #. 
This number can be used to create a new case 
later using historical entry (see Appendix 7 – 
Reserve Lab #). 

Object Repository 

Open Case 
Objects 

Opens Object Repository – [Case #] to 
view/manage objects for the case associated with 
the selected submission. 

Open Submission 
Objects 

Opens Object Repository – [Submission #] to 
view/manage objects associated with the selected 
submission. 

Options 
Item Descriptions Opens Evidence Descriptions form to add, change, 

delete, or copy evidence descriptions (see Figure 
26 – Evidence Descriptions). 

Submissions 

New Submission Opens New-Submission Entry form to start a new 
submission. 

Receive Evidence Opens Transfer Evidence form to receive evidence 
for the selected submission (see Figure 19 – 
Transfer Evidence). 

Open Selection’s Opens Batch Details for evidence associated with 
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Grouping Option Effect 

Evidence the selected submission (see Figure 30 – Batch 
Details). 

Submission 
Details 

Opens Submission Details to view or modify details 
of the selected submission. 

Add Submissions 
to Batch 

Opens Add Evidence to Batch to add evidence 
associated with selected submission(s) to a new or 
previous batch (see Appendix 51 – Add Evidence 
to Batch). 

Print Submission 
Labels 

Opens Submission Label to select options for 
printing submission labels for the selected 
submission (see Appendix 8 – Submission Label). 

Print Submission 
Report 

Opens Submission Report to select options for 
printing the submission report for the selected 
submission (see Appendix 9 – Submission Report). 

TERMINOLOGY 

The following table describes basic terms used throughout Forensic Advantage. 

Table 4 – Terminology 
Term Description 

Agency Case # Case Number assigned to a criminal investigation. 

Analysis Forms Collection of result data recorded by an examiner for one or more 
examinations within a single case record. 

Case Contains all case-related data including all submissions, case records, 
evidence, specimens, lab reports, etc. regarding an investigation. The 
Case is equivalent to the Master File. 

Case # FA-generated identifier for a case. The case number is the Lab File 
Number. 

Case Record Unit of work within the section or discipline that results in a single 
laboratory report. The Case Record is equivalent to the discipline 
assignment. 

Case Record # FA-generated identifier for a case record. A sequentially assigned 
number associated with a request for examination, typically by 
section/discipline. Combined with the Case (Lab File) number, it 
provides uniqueness to a specific result set (report). 

Chain of Custody The documented record of an individual piece of evidence while in the 
care and custody of the laboratory. 



Forensic Advantage Systems  Forensic Laboratory User Guide 

Version 15.1  Page 5 of 165 

Term Description 

Evidence Items and/or containers submitted to the office. 

Exams Unit of work that may be associated with a piece of evidence. 

Lab Report Official document of the results for a single case record. 

Management & 
Section Reports 

Management reports are statistical reports produced monthly, quarterly 
or yearly to provide information on the work product of the office. 

Offense Classification of the suspected criminal event. 

Primary Analyst Person assigned to oversee completion of the case. The Primary 
Analyst is the person assigned to complete the case. 

RFLE Request for Laboratory Examination (RFLE) is the source document 
completed by a submitter, which identifies the evidence submitted and 
the examinations requested. Paper RFLEs and supporting 
documentation can be scanned into FA for storage with the submission. 
RFLE is equivalent to a Laboratory Analysis Request. 

Submission Single instance for providing evidence and request for live exam to the 
laboratory. 

CONFIGURATIONS 

Several configurations exist to customize the FA application to accommodate user workflow. 
Not only are system configurations available for the core product, such as entering agencies 
into the system and being available within any case where needed, but most screens are also 
administratively configurable to alter layout, positioning, and visibility of the controls on screen. 
For example, if a particular data field is not necessary, the administrator may remove it from the 
user’s view. Administrator changes to the layout of a screen become the view seen by everyone 
who accesses the screen. This feature may also be reset back to the original setting. System 
date and time formatting is configurable for all date edit fields on all screens. Drop-downs within 
the system may also be configured to customize values specific to the user. 

Configurations may be added to enable limited visibility and access to cases based on 
jurisdiction (e.g. county investigators only have access to cases within their own county). 
Employees may be assigned to multiple counties or all counties. Access to screens is 
configured based on a list of over 130 tasks, which may be assigned according to employees’ 
work requirements. Viewing but not adding records, editing but not deleting records, and any 
other combination of add/edit/delete operations is supported. 

MANAGING SETTINGS 

The File Tab menu provides options for exporting information from FA and accessing user 
settings and notifications. 
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Figure 3 – File Tab Options 

Table 5 – File Tab Options 
Option Effect 

Export Opens Save As dialog to select a location in which to export data in 
one of the selected formats. 

Settings Opens Forensic Advantage Settings to select a signature pad display 
and select a Logging level (see Appendix 1 – Forensic Advantage 
Settings). 

User Settings Opens Notifications – User Settings to view and opt in or out of system 
notifications (see Figure 4 – Notifications - User Settings). 

Support Opens Forensic Advantage Support to display system information and 
current logs (see Appendix 2 – Forensic Advantage Support). 

Exit Exits the Forensic Advantage application. 

USER SETTINGS 
Notifications – User Settings (see Figure 4 – Notifications - User Settings) provides access to all 
system notifications and may be viewed according to Notification Type or Recipient Type. By 
default, all notification types are disabled. Administrators review each notification type, 
determine its applicability to their users, and set one of the following status options (see Table 6 
– Notification Status Descriptions). 

Table 6 – Notification Status Descriptions 
Notification Status Description 

Disabled Users will never receive notifications of this type. 

Required Users will always receive notifications of this type. 
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Notification Status Description 

Opt In Users will only receive notifications of this type if they opt in via User 
Settings (see Figure 4 – Notifications - User Settings). 

Opt Out Users will always receive notifications of this type unless they opt out 
via User Settings (see Figure 4 – Notifications - User Settings). 

 
Figure 4 – Notifications - User Settings 

To manage user notification settings: 

1) Click the File Tab at the top of the ribbon in the main FA user interface (see Figure 3 – 
File Tab Options). 

2) Select User Settings to open Notifications – User Settings (see Figure 4 – Notifications 
- User Settings). 

3) Select empty checkbox to Opt In to the associated notification. 
4) Deselect checkbox to Opt Out of the associated notification. 

Note: Required notifications may not be changed. 
5) Click Save in the Actions grouping of the ribbon to save any status changes. 
6) Click the red x in the upper right corner to close the form. 
7) Click the Home Tab to return to the main FA user interface. 



Forensic Advantage Systems  Forensic Laboratory User Guide 

Version 15.1  Page 8 of 165 

CUSTOMIZING YOUR WORKSPACE 

The View Tab ribbon offer multiple options for customizing the Contents Pane of Forensic 
Advantage. 

 
Figure 5 – My Work View 

Table 7 – My Work View – View Tab Ribbon Options 
Grouping Option Effect 

Navigate 

Modules Drop-down allows you to navigate to desired 
module. 

Go To Top Navigates to the top node displayed in the 
Navigation Pane. 

Grid Features 

Filters Toggles visibility of column filters. 

Group By Box Toggles visibility of Group Panel at top of 
Contents Pane. 

Column Chooser Toggles visibility of Customization box. 

Layout Preview Pane Toggles visibility of Preview Pane at the bottom 
of the Contents Pane. 

Grid Settings Load Opens Load Grid Settings to select previously 
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Grouping Option Effect 

saved grid settings from a file or database profile.

Save Opens Save Grid Settings to save current 
settings to a file or database profile. 

Restore Defaults Resets Contents Pane to default grid settings. 

SORTING 
Sorting is built into columns throughout the FA user interface. Click on a column header to sort 

 ascending. Click on the column header again to reverse order  descending. An arrow 
appears in the column heading to designate the current order of the column. Use Shift-click to 
sort multiple columns. 

FILTERS 
In each view within FA, the Filters button activates a list of column options. Selecting a menu 
option filters the Contents Pane to display only entries that match the selected criteria.  

To filter the Contents Pane: 

1) Click the View Tab at the top of the ribbon menu (see Figure 5 – My Work View). 
2) Select Filters in the Grid Features grouping of the ribbon to activate column filters. 
3) Click the filter icon ( ) in the appropriate column heading to select an available menu 

option. 
Note: Contents Pane will automatically update to display only the entries which 
match the selected column filters. 

4) Select Custom in the drop-down menu to open Custom AutoFilter (see Appendix 3 – 
Custom AutoFilter). 

5) Select an operator and enter specific values by which to filter (may enter * for wildcard 
search) then click OK. 

6) To reset the Contents Pane, select All from the drop-down menu for each column 
heading or deselect the checkbox next to the listed filters at the bottom of the Contents 
Pane. 

GROUPING 
Group Headers activate a Group Panel at the top of the Contents Pane to facilitate grouping 
entries according to headings and sub-headings.  

To use group headers to sort the Contents Pane: 

1) Click the View Tab at the top of the ribbon menu (see Figure 5 – My Work View). 
2) Click Group by Box in the Grid Features grouping of the ribbon to activate the Group 

Panel at the top of the Contents Pane. 
3) Right-click a column header and select Group by this Column to place the header in 

the group panel. 
4) Click the > next to an entry in the Contents Pane to expand/collapse the results. 
5) Repeat steps 3-4 to group by multiple sub-headings. 
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6) To reset the Contents Pane, right-click the column headings in the Group Panel and 
select Ungroup. 

COLUMNS 
Column Chooser activates a Customization box (see Figure 5 – My Work View) that contains all 
available column headings for the Contents Pane. Choose which characteristics to view in the 
Contents Pane for any view in FA. To adjust column width, drag the column edge, double-click 
the column divider to auto fit the width, or right-click and select Best Fit (all columns). 

To select which columns to view in the Contents Pane: 

1) Click the View Tab at the top of the ribbon menu (see Figure 5 – My Work View). 
2) Select Column Chooser from the Grid Features grouping of the ribbon to display 

Customization box. 
3) Right-click a column header in the Contents Pane and select Remove this Column to 

remove it from view and place it in the Customization box. 
4) Right-click a column header in the Customization box and select Show this Column to 

display the column in the Contents Pane. 

PREVIEW PANE 
The Preview Pane displays the Laboratory Request and Property Receipt (any document(s) that 
are imported into the Lab Request Scan tab of Submission Details) associated with the selected 
case. 

To display the Preview Pane: 

1) Select the Evidence or Case Processing module at the bottom of the Navigation Pane. 
2) Click the View Tab at the top of the ribbon menu (see Figure 5 – My Work View). 
3) Select Preview Pane from the Layout grouping of the ribbon. 
4) Select a case in the Contents Pane to view any documents that were imported into the 

Lab Request Scan Tab of Submission Details. 
Note: If the case has multiple submissions, the documents for each submission 
can be viewed by selecting the drop-down next to Submission. Each page of the 
submission documents can be viewed by selecting the drop-down next to Page. 

LIST GRID CONTENT 
The Title Bar of FA user interface offers options to print the current grid listing displayed in the 
Contents Pane. 

To print a grid listing: 

1) Customize Contents Pane of any view to display the appropriate information. 

2) Click Print Preview icon ( ) in title bar to open Preview (see Appendix 4 – Preview 
Grid Listing). 

3) Configure as desired. 
4) Print, Export or Email grid listing by selecting appropriate option from the File 

menu. 
5) When finished, click the red x in the upper right corner to close Preview. 
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GRID SETTINGS 
While many of the customization tools available for the Contents Pane are used to search and 
sort entries, they also create unique workspaces that suits individual needs. Thus, FA provides 
options to save grid settings. You can also import and load another employee’s grid settings in 
order to share effective organization techniques. 

To save grid settings: 

1) Click the View Tab at the top of the ribbon menu (see Figure 5 – My Work View) and 
customize the Contents Pane. 

2) Select Save from the Grid Settings grouping of the ribbon to open Save Grid Settings 
(see Appendix 5 – Save Grid Settings). 

3) Choose whether to Save to database profile, so other users may access, or Save to a 
file, for individual use. 

4) Enter a Name and click Save. 

To load grid settings: 

1) Click the View Tab at the top of the ribbon menu (see Figure 5 – My Work View). 
2) Select Load from the Grid Settings grouping of the ribbon to open Load Grid Settings 

(see Appendix 6 – Load Grid Settings). 

3) Select from saved database profiles or click  to browse for a previously saved file. 
4) Click Load to close the dialog and load grid settings into the Contents Pane. 
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Workflow 

 

STEP 1: SUBMISSION ENTRY 

Submission Entry is the beginning of the workflow process in the crime lab. The more 
information you enter in the submission tabs, the more complete the case. Select Search to 
determine if a previous request was submitted for a particular Incident Number, Property 
Receipt Number, or Party of Interest. 

To enter a new submission: 

1) Select the Evidence module and navigate to New Submissions View (under user’s 
primary lab) in the Navigation Pane. 

2) Select New from the File grouping of the ribbon menu or select New Submission from 
the Submissions grouping of the ribbon menu. 

3) New Submission screen opens (see Figure 7 – New Submission Details Tab). 
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4) On the Details Tab, ensure the Lab, Submission Type, Delivery Method and Return 
Method are correct, then select/enter the Primary Agency, Violation (Offense) and any 
other known information (see Details Tab). 

5) On the Officers Tab, Add an Investigating and Submitting Officer, as well as any other 
contributors for the submission (see Officers Tab). 

6) On the Exams Tab, select the Primary Dept and Add at least one Requested Exam (see 
Exams Tab). 

7) On the Parties of Interest Tab, may Add any individuals and/or businesses associated 
with the submission (see Parties of Interest Tab). 

8) On the Evidence Tab, Add at least one piece of evidence (see Evidence Tab). 
9) On the Description/Comments Tab, may enter Statement of Fact, Case Comments 

and/or Submission Comments (see Description/Comments Tab). 
10) On the Extended Data Tab, may enter any client specific information related to the 

submission or case (see Extended Data Tab). 
11) On the RFLE Scan Tab, may scan/import the Laboratory Request and/or Property 

Receipt (see RFLE Scan Tab). 
12) When data entry is complete, click Submit and choose whether to print labels (see 

Submit New Submission). 

NEW SUBMISSION SCREEN 
Populating information in the New Submission screen makes information available throughout 
the system without having to re-enter the same information in subsequent screens. This design 
increases data entry efficiency and increases data integrity throughout the system. Complete 
information on all necessary tabs before selecting Submit. Information is mandatory in the 
Details, Officer, Exams and Evidence tabs. Information is optional in the Parties of Interest, 
Description/Comments, Extended Data and Lab Request Scan tabs.  

See below for available ribbon menu options on the New Submission form. 

 
Figure 6 – New Submission Ribbon Menu 

Table 8 – New Submission Ribbon Options 
Grouping Option Effect 

File 

Submit Submits the information entered as a new 
submission. 

Search Opens Search to search for submissions using 
available criteria (see Appendix 10 – Search).  
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Grouping Option Effect 

Clear Clears information and RFLE scan images from 
the submission form. 

Manage Files Opens Object Repository to manage file for the 
existing submission. 

Report Opens Submission Preview dialog to select 
printer and format options for printing the 
submission report (see Appendix 9 – Submission 
Report). 

PreLog Import Request Opens Import RFLE to import a RFLE scan by 
number from the PreLog system (see Appendix 
11 – Import RFLE). 

Property Connect 

Import Evidence Opens a dialog to import evidence to the 
submisison. 

View Request Opens the Property Connect page in the FA 
Property Connect web app. 

Request Evidence Opens Request Evidence page in Property 
Connect web app. 

Refresh Refreshes any changes made to property 
connect. 

View 

Previous Tab Moves to the previous tab in the New Submission 
form. 

Next Tab Moves to the next tab in the New Submission 
form. 

Details Tab 
Case # (Lab #) is generated by the system when the Submit button is selected. Lab, 
Submission Type, Primary Agency and Violation (Offense) are required. 
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Figure 7 – New Submission Details Tab 

Officers Tab 
Submitting Officer and Investigating Officer are required. Add, change or remove officers for the 
submission (see Table 9 – Officers Tab Options). Officer information is grouped according to 
role(s) assigned. Officers can be assigned to more than one role. 
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Figure 8 – New Submission Officers Tab 

Table 9 – Officers Tab Options 
Option Effect 

Add Opens Choose Officer screen to select a previously entered officer or 
click New… to add an officer to the submission (see Appendix 12 – 
Choose Officer).  

Change Opens Officer Information to modify the displayed details of the 
selected officer or click Edit Officer… to edit full details for the officer 
(see Appendix 13 – Officer Information). 

Remove Removes the selected officer from the submission. 
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Exams Tab 
Primary Dept and at least one Requested Exam are required. Request Coordinator is the 
individual responsible for oversight on a particular case. After an exam is added, case record 
information is highlighted in the Case Records grid. 

 
Figure 9 – New Submission Exams Tab 

Table 10 – New Submission Exams Tab Options 
Option Effect 

Add Opens Add Exam to select the exam type and add it to a case record 
(see Appendix 14 – Add Exam). 

Remove Removes the selected requested exam from the submission. 

Modify Opens Modify New Case Record to modify the selected case record 
(see Appendix 15 – Modify New Case Record). 
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Parties of Interest Tab 
Enter the Victim(s), Suspect(s), Individual(s), and Business(es) listed on the Laboratory 
Request. Choose role of person(s) being added. Roles are also available on the drop-down 
within the Person form (see Appendix 16 – Person). 

 
Figure 10 – New Submission - Parties of Interest Tab 

Table 11 – Parties of Interest Tab Options 
Grouping Option Effect 

Persons 

Add… Opens Person form to capture details of a party 
of interest for the submission (see Appendix 16 – 
Person). 

Find Opens Search form at the Parties of Interest Tab 
to find previously entered persons (see Appendix 
17 – Search Parties of Interest Tab).  
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Grouping Option Effect 

Change Opens Person form to modify details of the 
selected person. 

Remove Removes selected person from the submission. 

Businesses 

Add Opens New Business form to capture details of a 
business related to the submission (see 
Appendix 18 – New Business). 

Find Opens Business Search form to find previously 
entered businesses (see Appendix 19 – Business 
Search). 

Change Opens Business Details to modify details of the 
selected business.  

Remove Removes the selected business from the 
submission. 

Evidence Tab 
Enter the evidence to be examined from the request. Evidence entered or imported into the 
system is not verified by default. "Verified" indicates that the physical evidence was observed in 
the lab. Until evidence is verified, it cannot be entered into an Analysis Form. Some actions, like 
transferring or assigning to an exam, will automatically verify the evidence. Once evidence is 
verified, it cannot be removed from the system without administrator or supervisor approval. 

Codes (or shortcuts) can be created to auto populate descriptions (e.g. Type “DCS” into the 
description field and it will auto populate the statement “DNA Collection Swab”). See Managing 
Evidence Descriptions for instructions on how to create or copy user defined evidence lists. 
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Figure 11 – New Submission Evidence Tab 

Table 12 – Evidence Tab Options 
Option Effect 

Add Opens New Submission – New Evidence to enter a new piece of 
evidence for the submission (see Figure 12 – New Evidence). 

Add Subitem Opens New Submission – New Evidence to add new evidence as a 
subitem of the selected evidence. 

Use Template Opens Create Evidence from Template to select evidence from a 
designated template. A template can be used to select from many 
possible items or to add a common collection, e.g. Sexual Assault Kit 
(see Appendix 20 – Create Evidence From Template). 

Resubmit Opens Transfer Evidence for a subsequent submission to select 
evidence which was returned to the agency location and is being 
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Option Effect 

resubmitted to the lab. 

Change Opens New Submission – New Evidence to modify the details of the 
selected evidence. 

Remove Removes the selected evidence from the submission. If the evidence 
has already been transferred to the lab, only an authorized user can 
remove it. 

To enter evidence: 

1) In New Submission form, select the Evidence Tab. 
2) Select Add to open New Submission – New Evidence (see Figure 12 – New Evidence). 
3) Designate Type of evidence as an Item or a Container of items.  

Note: Evidence # is automatically populated with next available # according to 
evidence type, but may be changed. 

4) Select the ‘For Analysis’ checkbox if the evidence is to be analyzed. 
5) Enter a description or click Description to open Select Item Description and select from 

a list of user defined descriptions (see Managing Evidence Descriptions to create a list of 
evidence descriptions). 

6) Enter any additional information available, as well as any comments related to the 
evidence. 

7) Click Add to add the evidence. 
8) Repeat steps 1-7 for additional evidence. 
9) When finished, click Close. 

To add bulk evidence: 

1) Select Evidence > New Evidence > New Subitem(s) from the menu bar or click on the 

arrow next to the New Evidence icon ( ) and select New Subitem(s) from the drop-
down to open New Evidence. 

2) Select the Multiple – Disables Additional Data radio button at the top of New Evidence. 
3) Select or enter Type, Agency #, Delivery #, Description and Comments for the bulk 

evidence. 
4) Select Parent, if applicable, and select the For Analysis checkbox if the bulk evidence is 

to be examined. 
5) Enter or verify the first evidence number and FA will sequentially number from that 

starting point. 
6) Click Add to open Add Multiple Evidence (see Appendix 25 – Add Multiple Evidence). 
7) Use arrows or manually enter the quantity and click Generate to populate the grid. 
8) Click Verified checkbox, if appropriate, then click Add. 
9) Add Multiple Evidence screen closes once evidence is loaded. 

Note: If adding more than 100 items of evidence, may take several minutes for 
evidence to load. 

10) Repeat steps 2-9 for additional bulk evidence entry. 
11) Click Close when finished entering evidence. 
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Figure 12 – New Evidence 

Description/Comments Tab 
Information in the Description/Comments Tab can be typed in or cut and pasted from an 
incident report. 
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Figure 13 – New Submission Description/Comments Tab 

Extended Data Tab 
Client specific information can be entered in the Extended Data Tab. 
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Figure 14 – New Submission Extended Data Tab 

RFLE Scan Tab 
RFLE Scan Tab provides access to the laboratory request and property receipt associated with 
the submission. Scan the Laboratory Request and Property Receipt (if available) as a .tiff file 

from the multi-function device to be imported into FA. Click the image icon ( ) to import the 
Laboratory Request and Property Receipt. 
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Figure 15 – New Submission RFLE Scan Tab 

SUBMIT NEW SUBMISSION 
After all available information has been entered in the New Submission form, select Submit to 
enter the submission into the system. Upon confirmation of the submission, user will have an 
opportunity to preview the information and the option to print submission labels, evidence labels, 
and submission reports (see Figure 16 – New Submission Confirmation Dialog 1). 

The number next to the label is the number of labels per submission and items of evidence. 
Evidence labels will print on the designated label printer in the format designed by the user. If 
the evidence came in a container, place the submission label on the container and all of the 
evidence labels with the container. If the evidence did not come in a container, place each 
evidence label on the appropriate piece of evidence. 
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Figure 16 – New Submission Confirmation Dialog 1 

After selecting OK, a second Confirmation dialog appears (see Figure 17 – Submission 
Confirmation Dialog 2), giving the assigned Case # (Lab #) and options to receive evidence, 
enter another submission, or finish the submission process. See Table 13 – Submission 
Confirmation Options for more information on each of these options. 
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Figure 17 – Submission Confirmation Dialog 2 

Table 13 – Submission Confirmation Options 
Option Effect 

Receive Opens Transfer Evidence form to receive the evidence for the 
submission (see Figure 19 – Transfer Evidence).  

Next Returns to the New Submission form to create another new 
submission, with any selected information retained. 

Finish Finishes the new submission and closes the Confirmation 
dialog. 

STEP 2: CASE ASSIGNMENT 

Case assignment may occur automatically by FA, depending on the examiner assignment 
method(s) enabled in the lab/section. However, if a case is not automatically assigned, it may 
be assigned using the Unassigned View in the Case Processing module (see Figure 18 – Case 
Processing - Unassigned View). 
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Figure 18 – Case Processing - Unassigned View 

To assign case(s) to an examiner: 

1) Select the Case Processing module at the bottom of the Navigation Pane. 
2) Expand user’s primary Laboratory and Section folders at the top of the Navigation Pane. 
3) Select the Unassigned folder to load Unassigned View (see Figure 18 – Case 

Processing - Unassigned View). 
4) Select the appropriate case(s). 

Note: Assign multiple cases to the same examiner by holding down CTRL and 
selecting each case individually or by holding down Shift and selecting a group of 
cases. 

5) Assign the case(s) to an examiner by one of two methods: 
a. Select the examiner name from the drop-down in the Contents Pane. 
b. Select Assign Examiner from the ribbon (see Appendix 22 – Select Examiner), 

highlight the examiner name and click OK. 
Note: May cancel assignments until assignments are committed. Cancel the 
assignment by selecting Cancel Assignments from the ribbon. 

6) Once case(s) are assigned, select Commit Assignments from the Assignment 
grouping of the ribbon. 
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STEP 3: EVIDENCE RECEIPT/TRANSFER 

Receive Evidence is the term used to indicate the first transfer of evidence after being entered 
into the system. For most evidence transfers, the transfer date and time are not editable; 
however, when receiving evidence, these values can be specified because the evidence may be 
electronically received before or after the evidence is physically received. 

 
Figure 19 – Transfer Evidence 

Table 14 – Transfer Evidence Fields/Options 
Option Description 

Select All Selects all evidence items in the grid for transfer. 

Select None Deselects all evidence items in grid. 

Transfer Type Select the type of evidence transfer from the drop down list. Current 
status of evidence selected for transfer determines available transfer 
types. 
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Option Description 

Transfer Reason Select reason for evidence transfer. Some transfer types may require 
selection of transfer reason. 

Received By 

At Lab 

At Dept 

Default places evidence in user’s personal custody at primary lab and 
section. Information may be changed. 

Transfer Date 

Transfer Time 
Default enters current date and time. 

Storage Area 

Storage Location 

Select Place in Storage checkbox to activate Storage Area and Storage 
Location fields. Only one transfer per target location, whether personal 
custody or storage location. 

Witness  If any witnesses are designated, they will need to enter their credentials 
in order to complete the transfer. 

Comments Enter any comments related to the evidence transfer. 

Split Select checkbox to record a separate transfer for each case. When 
applicable, separate receipts will be created for each case. If not 
selected, action will be recorded as a single (batch) transfer with all 
selected evidence.  

Print Receipt Print receipt(s) of the committed evidence transfer(s). Some transfer 
types, such as Submitted to Lab or Returned to Agency, may be 
automatically attached to the related case(s) as a PDF. 

Transfer Accepts transfer information for selected evidence, but does not close 
form, so additional transfers may be completed. Does not commit the 
transfer. Once all transfers are complete, select OK to commit the 
transfers. 

Help Opens Help topics related to evidence transfer. 

Ok Commits transfers and closes the form. 

Cancel Cancels evidence transfers and closes the form. 

To receive/transfer evidence for a new submission: 

1) Select the Evidence module and navigate to the New Submissions View (under user’s 
primary lab) in the Navigation Pane. 

2) Select the appropriate case # (lab #) in the Contents Pane. 
3) Select Receive Evidence from the Submissions grouping of the ribbon to open Transfer 

Evidence. 
4) Use Select All, Select None or checkboxes to select items for transfer. 
5) Select appropriate Transfer Reason and Transfer Type. 
6) Select destination for evidence.  
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Note: Defaults to personal custody, select Place in Storage checkbox to select a 
storage location. 

7) Choose witnesses from the drop-down lists, if needed. 
8) Select Split checkbox to record separate transfers for each case, if needed.  
9) Select Transfer to transfer the selected evidence to the specified location. 
10) Repeat steps 4-9 for any remaining evidence. 
11) When complete, select OK to commit the evidence transfer(s). 
12) Confirm transfer by entering password (login credentials). If witnesses are selected, their 

credentials are also required in order to complete the transfer. 
Note: If Received from Agency is selected as the transfer type, a pop-up window 
will appear for the Submitting Officer to sign using the Topaz Signature Pad. If the 
Submitting Officer is a Property Room, leave the signature window blank. 

To transfer evidence for outsourcing or independent testing: 

1) Select the Evidence module and navigate to the My Personal Custody View (under 
user’s primary lab and section) in the Navigation Pane. 

2) Select the appropriate evidence in the Contents Pane. 
3) Select Transfer Evidence from the Evidence grouping of the ribbon. 
4) Select all evidence items to be transferred. 
5) Select Transferred Out for Transfer Type and Outsourcing for Transfer Reason. 
6) In the Comments section, document where, how and when the evidence will be 

outsourced and tested. 
7) Click OK and enter login credentials to commit the transfer. 
8) Select a printer and click OK to print evidence transfer receipt. 

To transfer evidence out that you do not expect to be returned to the lab: 

1) Select the Evidence module and navigate to the My Personal Custody View (under 
user’s primary lab and section) in the Navigation Pane. 

2) Select the appropriate evidence in the Contents Pane. 
3) Select Transfer Evidence from the Evidence grouping of the ribbon. 
4) Select evidence items to be transferred.  
5) Select Consumed as the Transfer Type and Independent Testing as the Transfer 

Reason.   
6) In the Comments section, document where, how and when the evidence was consumed. 
1) Click OK and enter login credentials to commit the transfer. 

STEP 4: EVIDENCE EXAMINATION ASSIGNMENT 

Assign evidence to exams in the Evidence Tab of Case Details (see Figure 20 – Case Details 
Evidence Tab).  

To assign evidence to exams: 

1) Select the Case Processing module at the bottom of the Navigation Pane. 
2) Select My Work folder at top of the Navigation Pane or expand (click on > to left of 

folder) user’s primary lab and section folders to select My Case Records folder.  
3) Select the appropriate case from the Contents Pane. 
4) Select Case Details from the Cases grouping of the ribbon to open Case Details. 
5) Click on the Evidence Tab. 
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6) Select Actions > Assign Evidence from the menu bar or click Assign Evidence button 
in the toolbar to open Assign Evidence to Exams (see Appendix 23 – Assign Evidence to 
Exams). 

7) Assign the exams to the evidence by selecting the checkbox under the appropriate exam 
column, if needed (the column headers display the sections assigned to the case during 
submission entry).  
Note: If an item of evidence is greyed out, that indicates the evidence has not 
been selected for analysis and therefore cannot be examined. To select the 
evidence for analysis, double-click the item to open Evidence Details, select the 
“For Analysis” checkbox then click Save and Close. 

8) When finished, select Save and Close to save the assignments and close Assign 
Evidence to Exams. 

9) Select Save and Close to save changes and close Case Details. 

 
Figure 20 – Case Details Evidence Tab 

Table 15 – Case Details Evidence Tab Ribbon Options 
Icon Option Effect 

 
New Evidence Opens New Evidence to add new evidence to the case (see 

Figure 12 – New Evidence). Drop-down menu facilitates entry of 
New Subitem(s), New Unreceived Evidence, New Evidence 
Generated/Separated in Lab, New Inherited Evidence, and 
Use Template for entering evidence. 
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Icon Option Effect 

 
Modify Evidence Opens Evidence Details to modify the details of the selected 

evidence (see Appendix 24 – Evidence Details). 

 
Remove Evidence Removes selected evidence from the submission. 

 
Resubmit 
Evidence 

Opens Transfer Evidence to resubmit evidence that has been 
returned to agency location. 

 
Transfer Evidence Opens Transfer Evidence to transfer selected evidence to 

another lab, section, or examiner. 

 
Verify Evidence Marks selected evidence as verified, which indicates that the 

physical evidence was observed in the lab. 

 
Add to Batch Opens Add Evidence to Batch to add the selected evidence to a 

new or existing batch (see Appendix 51 – Add Evidence to 
Batch). 

 Chain of Custody Opens Chain of Custody Details for evidence related to the 
case (see Figure 27 – Chain of Custody Details). 

 
Print Evidence 
List 

Opens Preview to select options for printing the evidence list for 
the case. 

 
Print Evidence 
Labels 

Opens Evidence Label dialog to select options for printing labels 
for the selected evidence. 

STEP 5: EVIDENCE DETAIL ENTRY 

Evidence detail entry also occurs in the Evidence Tab of Case Details. See Table 12 – Evidence 
Tab Options for description of available evidence actions and see Managing Evidence 
Descriptions to learn how to create evidence description codes. 

To change an evidence description:  

1) Select the Case Processing module at the bottom of the Navigation Pane. 
2) Select My Work folder at top of the Navigation Pane or expand (click on > to left of 

folder) user’s primary lab and section folders to select My Case Records folder.  
3) Select the appropriate case from the Contents Pane. 
4) Select Case Details from the Cases grouping of the ribbon to open Case Details. 
5) Click on the Evidence Tab and select the appropriate evidence from the grid. 
6) Double-click the item, select Evidence > Modify Evidence from the menu bar or click 

the Modify Evidence icon ( ) in the ribbon to open Evidence Details. 
7) Change the description and then click Save and Close. 
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To create a subitem: 

1) Select Evidence > New Evidence > New Subitem(s) from the menu bar or click on the 

arrow next to the New Evidence icon ( ) and select New Subitem(s) from the drop-
down to open New Evidence. 

2) Select the Type of evidence. 
3) Evidence # is automatically assigned, but may be changed. 
4) Select the For Analysis checkbox if the item is to be analyzed. 
5) Select the Parent (Item it came from). 

Note: Parent item must be in your personal custody. 
6) Chain of Custody defaults to Inherited from… 
7) Verify the appropriate Created at Section. 
8) Enter a Description by typing in the Description field, clicking Description to select from a 

list of user defined descriptions or enter a code to auto populate the desired description 
(for more details, see Managing Evidence Descriptions). 

9) Enter any necessary Comments. 
10) Enter the Property Receipt Number and any other available information in the Additional 

Information section. 
11) Select the Add button to enter the new evidence.  
12) Repeats steps 2-11 to create additional subitems. 
13) When finished, select Close. 

STEP 6: RESULTS ENTRY 

The Analysis Tab of Case Record Details (see Figure 37 – Case Record Details - Analysis Tab) 
facilitates results entry. See the Analysis User Interface section for detailed instructions on 
navigating and using the analysis forms. 

To add a new analysis: 

1) Select the Case Processing module at the bottom of the Navigation Pane. 
2) Select My Work folder at top of the Navigation Pane or expand (click on > to left of 

folder) user’s primary lab and section folders to select My Case Records folder.  
3) Double-click the appropriate case in the Contents Pane or select Case Record Details 

from the ribbon. 
4) Click on the Analysis Tab of Case Record Details. 
5) Select All Exams, Remaining Exams or, holding down the Ctrl key, select specific 

examinations. 
6) Select individual evidence from the grid or select All Exams heading. 
7) Right-click and select New Analysis of Type > [Analysis Form Name] to open a blank 

Analysis User Interface (AUI), ready for results entry.  
8) In the AUI, click Add in the ribbon to view a dropdown list of available analysis forms. 

Note: If an analysis form has one or more child analysis forms, the child forms will 
be inactive until the parent analysis form is saved. 

9) Select the desired analysis form to add a new node to the Navigation Pane with an add 

icon . 
Note: An add icon indicates that a new node has been added. It also indicates that 
the form has not been saved. 
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10) Enter data into the appropriate form controls (see Table 17 – AUI Form Control 
Operations). 

11) When results entry is complete, click Save in the ribbon and add icon  will disapear, 
indicating the new analysis form has been saved. 
Note: Saving the analysis without filling in the required fields will cause a dialog 
to appear that specifies the missing field(s). 

12) Click Save & Close in the ribbon to return to Case Record Details. 
13) The Analysis Tab in Case Record Details now has a grouping for the new analysis entry. 

Note: If additional analysis is needed, create another analysis form, or edit the 
existing analysis form and add new entries. 

STEP 7: REPORT GENERATION 

The Final Report is the lab report created after all exams are performed and analysis results are 
entered. The Final Report Tab of Case Record Details (see Figure 38 – Case Record Details – 
Final Report Tab) displays any created reports as well as options for reviewing and releasing 
reports. 

To generate a report: 

1) Select the Case Processing module at the bottom of the Navigation Pane. 
2) Select My Work folder at top of the Navigation Pane or expand (click on > to left of 

folder) user’s primary lab and section folders to select My Case Records folder.  
3) Select the appropriate case from the Contents Pane. 
4) Double-click on the case record or select Case Record Details from the Case Records 

grouping of the ribbon to open Case Record Details. 
5) Click on the Lab Reports Tab. 
6) Click New Final Report in the ribbon, select Reports > New Final Report from the 

menu bar, or click the New Final Report icon ( ) on the toolbar and Generate Report 
– Basic Report opens (see Figure 21 – Generate Report). 

7) Ensure the correct Agency is selected and click the Show checkbox to display the 
agency information in the report. 

8) Select whether or not to display any listed Investigating or Carbon Copy Officers, and 
Add additional officers, if necessary. 

9) Click Show checkbox to display any Persons of Interest. 
10) Click Show checkbox for any Additional Report Text needed. 
11) Select Create to create the report, close the window, and display a Basic Report with 

Draft status in the Final Report Tab. 
12) Select Save and Close when finished with Case Record Details. 
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Figure 21 – Generate Report 

STEP 8: REVIEW AND APPROVAL 

The review process aids in maintaining the accuracy and integrity of examination results. To 
request a review after the final report has been released (e.g. Quality Review), it must be done 
from the Contents Pane. See Review Management for information on accepting, completing, 
returning and continuing reviews. 

To request a review in Case Record Details: 

1) Select the Case Processing module at the bottom of the Navigation Pane. 
2) Select My Work folder at top of the Navigation Pane or expand (click on > to left of 

folder) user’s primary lab and section folders to select My Case Records folder.  
3) Select the appropriate case from the Contents Pane. 
4) Double-click on the case record or select Case Record Details from the Case Records 

grouping of the ribbon to open Case Record Details. 
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5) Select Request Review in the ribbon to open Review Details. 
6) In the Details Tab, select the Review Type. 
7) Click on the Reviewers Tab. 
8) Select an individual(s) from the Available Reviewers list then click the Add > button, click 

the Add Reviewer icon ( ) on the toolbar or go to Actions > Add Reviewer in the 
menu bar. 

9) Repeat step 7 for any additional reviewers. 
10) Select Save and Close. 

To request a review from the Contents Pane: 

1) Select the Case Processing module at the bottom of the Navigation Pane. 
2) Select My Work folder at top of the Navigation Pane or expand (click on > to left of 

folder) user’s primary lab and section folders to select My Case Records folder.  
3) Select the appropriate case from the Contents Pane. 
4) Select Request Reviews from the Case Records grouping of the ribbon to open Review 

Details. 
5) In the Details Tab, select the Review Type. 
6) Click on the Reviewers Tab and select an individual(s) from the Available Reviewers list. 

7) Click the Add > button, the Add Reviewer icon ( ) on the toolbar or go to Actions > 
Add Reviewer in the menu bar to add the selected reviewer to the Request Sent To list. 

8) Repeat step 7 for any additional reviewers. 
9) Select Save and Close. 

To request reviews for multiple cases: 

1) Select the Case Processing module at the bottom of the Navigation Pane. 
2) Select My Work folder at top of the Navigation Pane or expand (click on > to left of 

folder) user’s primary lab and section folders to select My Case Records folder.  
3) In the Contents Pane, select multiple cases by holding down CTRL and selecting each 

case individually or by holding down Shift to select a group of cases. 
4) Select Request Reviews from the Case Records grouping of the ribbon to open Review 

Details. 
5) In the Details Tab, select the Review Type. 
6) Click on the Reviewers Tab and select an individual(s) from the Available Reviewers list. 

7) Click the Add > button, the Add Reviewer icon ( ) on the toolbar or go to Actions > 
Add Reviewer in the menu bar to add the selected reviewer to the Request Sent To list. 

8) Repeat step 7 for any additional reviewers. 
9) Select Save and Close. 

STEP 9: RELEASE RESULTS 

If reviews are required or requested for a case, they must be completed before the report may 
be released. Only cases with Pending Release status may release results. Once a final report 
has been released, the document can no longer be changed. The case status is set to 
Complete and the case record is moved to the Completed node under the Case Records node 
in the Navigation Pane. 

To release a lab report: 

1) Select the Case Processing module at the bottom of the Navigation Pane. 
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2) Select My Work folder at top of the Navigation Pane or expand (click on > to left of 
folder) user’s primary lab and section folders to select My Case Records folder.  

3) Select the appropriate case record from the Contents Pane. 
4) Select Release Report from the Case Records grouping of the ribbon or open Case 

Record Details, select the Lab Reports Tab and select Release Lab Report. 
5) Select Yes on the Confirmation dialog to complete the case record and finalize the lab 

report. 
6) Use the checkboxes to select the documents to publish and enter any Comments on the 

Publish dialog (see Appendix 32 – Publish), then select Publish. 

STEP 10: RETURN EVIDENCE 

There are several places from which you can return evidence to the submitting agency. If you 
are working in Case Record Details, simply click on the Evidence Tab and choose Transfer 
Evidence from the toolbar or actions menu. If you are not currently working with the case 
record, you could use Ready to Return node or My Personal Custody node when ready to return 
evidence. 

 
Figure 22 – Ready to Return View 
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To return evidence: 

1) Select Evidence module at the bottom of the Navigation Pane and select Ready to 
Return folder from the top of the Navigation Pane. 

2) Enter appropriate criteria and select Search to find all submissions that match selected 
criteria and whose evidence is ready to be returned to agency. 

3) Select the appropriate case record in the Contents Pane. 
4) Select Return Evidence from the Evidence grouping of the ribbon (see Appendix 33 – 

Return Evidence). 
5) Use checkboxes to select items for transfer. 
6) Select appropriate Transfer Reason and Transfer Type. 
7) Ensure Employee, Laboratory, and Dept. are correct. 
8) Enter any necessary Comments. 
9) Specify Return Method and enter Return Package ID, if returning by mail. 
10) Return to Agency Transfer Type activates checkboxes to return evidence to the Inv. Off. 

or Sub. Off., or click Add to select Return Officer(s) from a specific agency. 
11) Select Split checkbox to record separate transfers for each case, if needed.  
12) Select Transfer to transfer the selected evidence to the specified location. 
13) Repeat steps 4-9 for any remaining evidence. 
14) When complete, select OK to commit the evidence transfer(s). 
15) Confirm transfer by entering password (login credentials). 

NOTE: If Returned to Agency is selected as the transfer type, a pop-up window 
will appear for the Submitting Officer to sign using the Topaz Signature Pad.  

To return evidence that was transferred out for outsourcing: 

1) Select the Go to Case # icon ( ) in the upper right corner of the FA user interface.  
2) Enter the Case # (Lab #) and click OK to open the associated Case Details. 
3) Select the Evidence Tab and highlight the appropriate evidence. 

4) Click the Transfer Evidence icon ( ) or select Evidence > Transfer Evidence from 
the menu bar. 

5) Select Transferred In as the Transfer Type. 
6) In the Comments section, document who, how, and when the evidence is transferred in. 
7) Click OK and enter login credentials to commit the transfer. 

Analysis User Interface 
Users assigned as members of a specific Lab/Section have permission to add, edit and delete 
Analysis User Interface (AUI) forms associated with their designated Lab/Section.  

ANALYSIS FORM 

Analysis forms are used to enter results for various exams performed on the evidence 
associated with a specific case record. See below for a sample analysis form and available 
ribbon menu options. 
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Figure 23 – Sample Analysis Form 

Table 16 – Analysis Form Ribbon Options 
Grouping Option Effect 

Actions 

Save & Close Saves examination information and closes the 
form. 

Print Preview Opens Generate Document to select a template 
for previewing the automated report generated 
from the entered examination results. 

Data 

Save Saves the data entered. Required before adding 
sub-exams. 

Add Click arrow to select from list of available exams 
for the current analysis form. 

Delete Deletes the current section of information. 

Manage 
Evidence Opens Assign Exams to Analysis to assign 

additional evidence to the current analysis. 
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Grouping Option Effect 

Files Opens Object Repository to view or add any files 
or images associated with the case record. 

Resources Opens Analysis - Resources to add resources to 
the analysis (see Appendix 26 – Analysis 
Resources). 

Activity Opens Activity form to manage activities 
associated with the analysis and associated case 
record (see Appendix 27 – Activities). 

Parties of Interest Opens Parties of Interest to add a person or 
business of interest to the associated case 
record (see Appendix 28 – Case Record # – 
Parties of Interest). 

Communication 
Log 

Opens New Communication Log Entry to enter or 
reply to conversations associated with the case 
record (see Appendix 29 – New Communication 
Log Entry). 

Reviews Opens Review Management to manage reviews 
for the associated case record (see Appendix 30 
– Review Management). 

Results 

Generate Generates any result statements associated with 
the analysis form related to the entered 
examinations. 

View Opens Analysis Results to view the generated 
result statements for the analysis form (see 
Appendix 31 – Analysis Results). Note: Must 
Generate statements to activate View. 

To add a new analysis: 

1) Select the Case Processing module at the bottom of the Navigation Pane. 
2) Select My Work folder at top of the Navigation Pane or expand (click on > to left of 

folder) user’s primary lab and section folders to select My Case Records folder.  
3) Double-click the appropriate case in the Contents Pane or select Case Record Details 

from the ribbon. 
4) Click on the Analysis Tab of Case Record Details. 
5) Select All Exams, Remaining Exams or, holding down the Ctrl key, select specific 

examinations. 
6) Select individual evidence from the grid or select All Exams heading. 
7) Right-click and select New Analysis of Type > [Analysis Form Name] to open the AUI.  
8) In the Analysis User Interface (AUI), click Add in the ribbon to view a dropdown list of 

available analysis forms. 
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Note: If an analysis form has one or more child analysis forms, the child forms will 
be inactive until the parent analysis form is saved. 

9) Select the desired analysis form to add a new node to the Navigation Pane with an add 

icon . 
Note: An add icon indicates that a new node has been added. It also indicates that 
the form has not been saved. 

10) Enter data into the appropriate form controls (see Table 17 – AUI Form Control 
Operations). 

11) When data entry is complete, click Save in the ribbon and add icon  will disapear, 
indicating the new analysis form has been saved. If adding multiples of the same exam, 
the exams will display in the order in which they are saved. 
Note: Saving the analysis without filling in the required fields will cause a dialog 
to appear that specifies the missing field(s). 
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Figure 24 – Analysis Form Add Menu 

To add a child node to an analysis form: 

1) Select the parent analysis form node in the Navigation Pane.  
2) Click Add in the ribbon and a drop-down list of available analysis forms will appear along 

with a list of available child analysis forms (see Figure 24 – Analysis Form Add Menu). 
Note: Any child node analysis forms are listed first, above the dotted line.  

3) Select the desired child analysis form to add a new child node to the Navigation Pane, 

under the parent analysis form node, with an add icon .  
Note: An add icon indicates that a new node has been added. It also indicates that 
the form has not been saved. 

4) Enter data into the appropriate form controls (see Table 17 – AUI Form Control 
Operations). 
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5) When data entry is complete, click Save in the ribbon and add icon  will disappear, 
indicating the new child analysis form has been saved. 
Note: Saving the analysis without filling in the required fields will cause a dialog 
to appear that specifies the missing field(s). 

To edit an existing analysis form: 

1) In the Analysis User Interface (AUI) Navigation Pane, select the node for the analysis 
form that requires editing.  

2) Click Edit in the ribbon to unlock the fields and check-out the selected analysis form for 
editing. 

3) Once a field is selected to edit, the analysis form node in the Navigation Pane will 

display an edit icon . 
Note: The edit icon indicates the node is being edited and the data in the form has 
not been saved. 

4) After completing needed edits, click Save in the ribbon and the edit icon  will 
disappear, indicating the edited analysis form has been saved.  

To delete an existing analysis form: 

1) In the Analysis User Interface (AUI) Navigation Pane, select the node for the analysis 
form that needs to be deleted. 

2) Click Delete in the ribbon and a Confirm Deletion dialog box will appear.  
3) Select Yes to confirm deletion of the selected analysis form. 

Note: If an analysis form has child analysis form(s), each of the child analysis 
form(s) must be deleted before deleting the parent analysis form. If the child 
analysis form(s) have not been deleted, the Delete button will be disabled for the 
selected analysis form. 

AUI FORM CONTROLS 

Analysis forms contain various form controls to capture data. See the table below for 
descriptions of the available form controls and associated operations. 

Table 17 – AUI Form Control Operations 
Type Representation Operation 

Checkbox  Select checkbox to indicate value is 
True (1) or clear checkbox to indicate 
value is False (0). 

Date Picker 

 

Select a date from the date picker by 
selecting the drop-down arrow or by 
typing the date in the data control. 
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Type Representation Operation 

Drop-down 

 

Select a value by selecting the drop-
down arrow and clicking the value. 
Drop-down values are tied to lookup 
tables and can be managed by FA 
Administrator. 

File Control Right-click on the File control and 
select Add to add file(s) to the File 
control placeholder (see Appendix 37 
– Select – File). If a file exists in the 
File control placeholder, user can 
Open, Save As, Edit Details or 
Delete using the right-click menu 
options. 

Grid Control 

 

Double-click in the grid control to 
open a form populated with evidence 
or resources associated with the 
case record (see Appendix 34 – 
Select Evidence and Appendix 35 – 
Select Resources). 

Image Control Right-click on the Image control and 
select Add to add image(s) to the 
Image control placeholder (see 
Appendix 36 – Edit – Image). If an 
image exists in the Image control 
placeholder, user can Open, Save 
As, Edit Details or Delete using the 
right-click menu options. 

Multi Select List 

 

 

Double-click in Multi Select List 
control to open form populated with 
values associated with the field (see 
Appendix 38 – Select Values). Select 
multiple values in the same field. 
Multi Select List values are tied to 
the lookup tables and can be 
managed by FA Administrator. 
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Type Representation Operation 

Multi Type List 

 

 

Type multiple values within the same 
field using Multi Type List control. 
Multi Type Lists are used for entering 
text or date values. 

Rich Text Double-click on Rich Text control to 
open Editor (see Appendix 39 – Rich 
Text Editor) and type detail 
information. Unlike Text control, Rich 
Text does not have a character limit. 

Spin Edit  Enter decimal or whole number 
values using up and down arrows or 
by typing the value directly into the 
control. If the Spin Edit control is set 
as a decimal, FA Administrator can 
control the number of decimal 
places. 

Text 
 

Type limited character data using 
Text control. The character limits are 
pre-defined in the AUI Forms. 

To upload file(s) using file control: 

1) Right-click on the file control in the AUI form and select Add.  
2) The Select - File window opens (see Appendix 37 – Select – File). 

Note: If a file exists in the file control placeholder, user can Open, Save As, Edit 
Details or Delete using the right-click menu options. 

3) Enter a File Name and click Browse to navigate to the folder where the file is located. 
4) Click Open to upload the file.  
5) Enter Description and Comments as necessary. 
6) Click Update & Close in the ribbon to close Select - File window and populate the file 

control. 

To add evidence/item(s) using evidence grid control: 

1) Double-click the evidence grid control in the AUI form. 
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2) The Select Evidence window opens with a list of Evidence(s)/Item(s) assigned to the 
case record. 

3) Select evidence(s)/item(s) by selecting the checkboxes.  
Note: Select All, Select None or Invert Selection by clicking appropriate buttons in 
the ribbon. 

4) Click Update & Close in the ribbon to close Select Evidence window and populate the 
evidence grid control. 

To enter resources using resource grid control: 

1) Double-click the resource grid control in the AUI form.  
2) The Select Resources window opens with list of resource(s) assigned to the case 

record. 
3) Select resource(s) by selecting the checkboxes.  

Note: Select All, Select None or Invert Selection by clicking appropriate buttons in 
the ribbon. 

4) Click Update & Close in the ribbon to close Select Resources window and populate the 
resources grid. 
Note: If no resources are available in Select Resources, see Manage Analysis Form 
Resources to add resources via Resource Manager. 

To add image(s) using image control: 

1) Right-click on the image control in the AUI form and select Add.  
2) The Edit-Image window opens (see Appendix 36 – Edit – Image). 

Note: If an image exists in the Image control placeholder, user can Open, Save As, 
Edit Details or Delete using the right-click menu options. 

3) Provide the File Name, Description and Comments as necessary. 
4) Right-click the image control and select Load.  

Note: May also Paste an image into the Image control. 
5) Navigate to the folder where the image is located, then click Open to upload the image. 
6) Click Update & Close in the ribbon to close Edit-Image window and populate image 

control. 

To enter multiple values using multi type list control: 

1) Click the + button located at the bottom of the multi type list control.  
Note: May also use Insert button on the keyboard to add a new row. 

2) A new row appears with the option to type in the text value or date. 
Note: As new rows are added, a scroll bar appears to see the complete list. 

3) Select – button at the bottom of the multi type list to remove an empty row.  
4) To delete an entry, click out of the field and use Up and Down arrow buttons on the 

keyboard to select the appropriate row and then click – button.  
Note: May also use Delete button on the keyboard to delete the highlighted row. 

To enter multiple values using multi select list control: 

1) Double-click the multi select list control in the AUI form.  
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2) Select Values window (see Appendix 38 – Select Values) opens with list of options 
related to the field. 
Note: Values are tied to lookup tables, which are managed by the FA 
Administrator. 

3) Select value(s) by selecting the checkboxes.  
Note: Select All, Select None or Invert Selection by clicking appropriate buttons in 
the ribbon. 

4) Click Update & Close in the ribbon to close Select Values window and populate the 
multi select list control. 

To enter data using rich text control: 

1) Double-click the rich text control or click on the rich text control in the AUI form and hit 
Enter on the keyboard.  

2) Editor window opens (see Appendix 39 – Rich Text Editor) with ribbon options for 
formatting, editing and checking spelling. 

3) Type in the detail information as necessary. 
4) Click Update & Close in the ribbon to close Editor window and populate rich text control.
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NAVIGATING ANALYSIS USER INTERFACE (AUI) FORMS 

The size of an Analysis User Interface (AUI) forms depends on the discipline and the case. 
Some disciplines use AUI with multiple layers of analysis forms whereas other disciplines use 
AUI with a single analysis form. Similarly, even a small size analysis form could become very 
large depending on the case. FA provides two features to facilitate navigating large AUIs: 

 Key Values in the Navigation Pane 
 Selecting Rows in the Grid Controls 

KEY VALUE(S) IN THE NAVIGATION PANE  
Most analysis forms within the Analysis User Interface (AUI) have one or more key values 
assigned to help differentiate between repeating analysis forms. The designation of key values 
are determined by the lab as an internal practice. FA does not designate any key values in the 
analysis forms. Generally, the key values are the Evidence(s)/Item(s) selected in the analysis 
form. However, some analysis forms use a combination of multiple fields as the key value (see 
Figure 23 – Sample Analysis Form). Key values represent the fields within the analysis form that 
would potentially make the data entry for the analysis form incomplete. 

FA Administrators have permissions to add, edit or remove the key values assigned to the 
analysis forms within each AUI. The key fields for each AUI are client specific and not user 
specific. After data is entered into the analysis form, the designated key values appear to the 
right of the analysis form node in parenthesis (see Figure 23 – Sample Analysis Form). 
Navigate between analysis forms by selecting the node with the appropriate key values. 

SELECTING ROWS IN THE GRID CONTROLS  
FA assigns a grid table to each analysis form that contains child node analysis form(s) to 
provide an overview of the data entered into each child node analysis form(s). Double-clicking a 
row in the grid table opens the associated child analysis form. The main area of the AUI 
displays the selected child node analysis form along with the previously populated data. 

CONFIGURING GRID COLUMNS 

Grid columns in the Analysis User Interface (AUI) forms may be customized per user. Once the 
user customizes the grid columns, the layout is stored in FA. See Customizing Your Workspace 
for explanation on how to sort and filter grid columns. 

To customize grid columns: 

1) Select a grid table in an analysis form. 
2) Right-click on a column header and select Column Chooser to open Customization box 

with list of hidden columns. 
Note: If there are no hidden columns, the box will be empty.  

3) Drag and drop column headings from the Customization box to the grid table. 
4) To hide a column, drag the column to the Customization box or right-click on the column 

header and select Remove This Column. 
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Object Repository 
The Object Repository is where files and images are stored. The Object Repository tracks all 
access to the files it maintains. When files are checked out for editing, they are locked such that 
multiple users cannot have a file out for modification simultaneously. When files are checked in, 
the previous version is not overwritten. The new file simply becomes a new version of the file. 
Each version is tracked with who uploaded the revision and when. The Object Repository 
provides visibility to users and administrators of the change log for critical files. 

 
Figure 25 – Object Repository 

Table 18 – Object Repository Ribbon Options 
Grouping Option Effect 

Open 

Details Opens File Properties for the selected file (see 
Appendix 40 – File Properties). 

File > Open Downloads the selected file to a local cache and 
automatically launches the application associated 
with the extension. 

File > Download a 
Copy 

Downloads a copy of the selected file to the local 
drive. 

Version History Opens Version History screen to view version 
history and download selected version to the 
local drive (see Appendix 41 – Version History). 
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Grouping Option Effect 

Add 

New Opens Select Template Source to add a new file 
to the object repository. 

Import Opens dialog to select one or more files to import 
into the repository. 

Modify 

Check Out Allows user to select a local folder for storage of 
file and marks record as checked out, preventing 
other users from modifying file until it is checked 
back in. 

Check In Checks in the updated file and makes file 
available for checkout. 

Undo Checkout Cancels the current checkout information. 

Update Allows user to browse to the updated file, marks 
file with new version # and checks it back in. 
Note: Cannot update a file which is checked 
out. 

Links 

Approve Approves selected file link(s). 

Delete Deletes the files’ links from the current entity. If a 
file is linked only to the current entity, deletes the 
actual file. 

Copy/Move Opens Copy/Move Files to move unapproved 
files or copy any files from one entity to another 
(see Appendix 42 – Copy/Move Files). 

Tools 

Refresh Refreshes the list of files associated with the 
entity. 

Manage 
Templates 

Opens another Object Repository which contains 
template documents that act as source files when 
creating a new file with the New button. 

TYPES OF OBJECT REPOSITORIES 

CASE OBJECT REPOSITORY 
Typically used to collect files associated with the entire case over (potentially) many case 
records. These include subpoenas, court orders, etc. 
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CASE RECORD OBJECT REPOSITORY 
Typically used to collect files associated with the completion of a single discipline’s case record. 
These could include spectra, chromatograms, electropherograms, other instrumentation files, 
photos, officer affidavits, sexual assault evidence collection notes, etc. 

SUBMISSION OBJECT REPOSITORY 
Used to collect files associated with the submission of evidence, such as the submission form. 

SECTION OBJECT REPOSITORY 
Used to collect files associated with the laboratory section, such as the section specific policies 
or procedures. 

EVIDENCE OBJECT REPOSITORY 
Used to collect information associated with evidence items, such as the sexual assault kit 
circumstances or location found. 

RESOURCE MANAGER OBJECT REPOSITORY 
Typically used to collect files associated with a specific resource instance. These could include 
an instruction set or recipe for a reagent preparation, printout of test or calibration results, 
documentation of a manufacturer’s instruction sheet, log sheets, etc. 

WORKING WITH OBJECTS 

Objects can be imported from your computer, digital camera, or other source. Once a file is 
imported into the Object Repository, it can be viewed, edited, copied or moved from one entity 
(e.g. case record, laboratory, department) to another. However, once an object is approved, it 
cannot be deleted or moved (only copied) without an administrator. 

To import an object: 

1) Select the Case Processing module at the bottom of the Navigation Pane. 
2) Select My Work folder at top of the Navigation Pane or expand (click on > to left of 

folder) user’s primary lab and section folders to select My Case Records folder.  
3) Select the appropriate case record from the Contents Pane. 
4) Open the appropriate Object Repository using the options in the Object Repository 

grouping of the ribbon (see Table 18 – Object Repository Ribbon Options). 
5) Or, select Case Record Details from the Case Records grouping of the ribbon and then 

click the Case Record Files icon ( ) on the toolbar or go to Actions > Manage > Case 
Record Files in the menu bar. 

6) In Object Repository (see Figure 25 – Object Repository), select Import from the ribbon 
to browse and find a file, then click Open. 
Note: May also drag and drop files from Windows Explorer or emails from 
Outlook.  

7) In File Properties (see Appendix 40 – File Properties) enter the Name and Description 
for the file or object, to appear in the object list, then click Save & Close. 

8) Select new object and click Approve from the Links grouping of the ribbon to protect the 
file, if needed. 
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Note: Once a file is approved, it cannot be changed, deleted or moved without an 
administrator. 

To view an object: 

1) Select an entry in the grid and click Details from the Open grouping of the ribbon or 
double-click the selection to open File Properties (see Appendix 40 – File Properties) for 
the object. 

2) Click File > Download a Copy, select a location and file name, click Save and navigate 
to selected location to open and view the object. 

To edit an object in the object repository: 

1) Select the entry in the grid and click Check Out from the Modify grouping of the ribbon. 
2) Select a folder in which to save a copy of the object and click OK. 
3) Navigate to the selected folder on your machine, make needed changes to the file and 

save. 
4) Select the object in the grid and click Check In from the Modify grouping of the ribbon. 

Note: Status will change and version will update to next sequential number. 

To copy/move an object: 

1) In Object Repository, select the object to be moved/copied. 
2) Click Copy/Move from the Links grouping of the ribbon to open Copy/Move Files. 
3) Click Select Entity from the Target grouping of the ribbon to open Select Entity. 
4) Expand entity, if needed, select the Case #/Section to be moved/copied to and click 

Select. 
5) Select Move to Target or Copy to Target from Source grouping of ribbon to share 

object with another entity. 
6) Select Move to Source of Copy to Source from Target grouping of ribbon to share 

another entity’s object(s) with current entity. 
7) Click red x in upper right corner to close Copy/Move Files and return to Object 

Repository. 

OBJECT TEMPLATES 

Another feature available in the Object Repository is object templates. Create and store 
templates per lab section such as line drawings of standard clothing items, standard images, 
checklists, or Office document templates. 

To access templates: 

1) In Object Repository, click Manage Templates in the Tools grouping of the ribbon to 
open Object Repository – Repository Templates. 

2) View current templates, Import a file as a template, or create a New template based on 
an existing template. 

To create a new object based on a template: 

1) In Object Repository, click New in the Add grouping of the ribbon to open Select File 
dialog. 

2) Select the appropriate template and click OK. 
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3) Enter a unique name for the template and click Save & Close to upload a copy of the 
template to the current Object Repository. 

INTEGRATION SERVICES 

The Instrument Integration server moves files into FA’s object repository. The deployment of the 
services includes a drop folder, usually a Windows file share, on a designated server. If you 
drop a file into the drop folder, the Instrument Integration Server will take the file and move it 
into Object Repository. You can use it to get a file into Object Repository without having to load 
FA. Also, various instruments around the lab, with access to the drop folder, could place result 
files into the drop folder to get results into Object Repository. How you name the file determines 
where the file will end up in Object Repository. A file with the name of “1_2012-
0001_1_MyFile.pdf” will attach to case record #1 of case 2012-0001. A file name is made of 
multiple parts separated by underscores.  

The rules for the file name are as follows: 

 If you want to attach the file to a case record, name the file “1_A_B_fileName” where A 
is the case # and B is the case record #. 

 If you want to attach the file to a case, name the file “2_A_fileName” where A is the case 
#. 

 If you want to attach the file to a submission, name the file “3_A_C_fileName” where A is 
the case # and C is the submission #. 

 If you want to attach the file to a Lab/Section, name the file “4_D_E_fileName” where D 
is the Lab Code and E is the Section Code. The section codes are unique to each client 
and setup by FA Administrator. 

 If you want to attach the file to a piece of evidence, name the file “5_A_F_G_fileName” 
where A is the case #, F is the evidence type and G is the evidence Id. 

By default, in the shared folder of each instance of FAS Integration Services, there are 3 sub-
folders named Processing, Processed and Error. 

When the processing starts, the files are dropped into the share and are moved to Processing 
sub-folder. Once the processing completes, the files end up in one of two sub-folders: Error or 
Processed. The Processed folder is used to indicate that the file was successfully moved into 
Object Repository. The Error folder is used to indicate that there was problem (most likely, the 
file was incorrectly named) and the file could not be added to Object Repository. If processed 
correctly, the file should appear in the repository on the central server immediately. 

Important Notes: 

 Do not rename or delete the three system-use sub-folders (Processing, Processed 
and Error). 

 Do not create any sub-folders in the share. Although people have permissions to 
create sub-folders in the share, the FAS Integration Services does not process 
sub-folders. 

 If your file(s) ends up in the Error sub-folder, please make sure that you delete the 
file from the Error folder before you attempt to put the file(s) back into the share 
again. 
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Working with Evidence 
The Evidence module facilitates the processing of evidence transfers and maintains the chain of 
custody. The initial receipt of evidence and its eventual return or disposition is recorded. In 
addition to managing the disposition of evidence, functions are provided to facilitate the official 
identification and description of evidence following submission entry. 

MANAGING EVIDENCE DESCRIPTIONS 

Evidence Codes (or shortcuts) can be created to auto populate evidence descriptions (e.g. Type 
“DCS” into the description field to auto populate the statement “DNA Collection Swab”). The 
User Description Tab contains descriptions unique to the individual user. The System 
Descriptions Tab contains descriptions available to everyone. However, personal user 
descriptions trump system wide descriptions. (e.g. If a user has DCS meaning DNA Collection 
Swab and the system has DCS meaning Digital Camera System, when the user types in DCS, 
DNA Collection Swab will appear). 

 
Figure 26 – Evidence Descriptions 

Table 19 – Evidence Descriptions Options 
Option Effect 

Add Opens User-Defined Evidence Descriptions dialog (see Appendix 48 – 
User Defined Evidence Description) to add a code, type and description 
association. 

Change Opens User-Defined Evidence Descriptions dialog (see Appendix 48 – 
User Defined Evidence Description) to modify the selected evidence 
description. 
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Option Effect 

Delete Deletes the selected evidence description. 

Copy Opens Select Employee to Copy (see Appendix 49 – Select Employee 
to Copy) to select another user’s evidence description list to copy. 

To create a user defined evidence list: 

1) In the Evidence Tab of the New Submission screen, click Add to open New Evidence. 
2) Select the Description button to open Select [Evidence] Description. 
3) Select the Manage button (or click Item Descriptions in the Options grouping of the 

ribbon in Evidence or Case Processing views).  
4) Click on the User Descriptions Tab and select Add. 
5) Make sure Item is selected for the Type. 
6) Enter a Code (must be three characters) and corresponding description. 

Note: Codes and Descriptions are case sensitive. 
7) Click Add to add to user list and repeat steps 5-6 for any additional evidence codes. 
8) Click Close to view User Evidence Description list and click Save to close Evidence 

Descriptions. 

To copy evidence descriptions: 

1) In the Evidence Tab of the New Submission screen, click Add to open New Evidence. 
2) Select the Description button to open Select [Evidence] Description. 
3) Select the Manage button (or click Item Descriptions in the Options grouping of the 

ribbon in Evidence or Case Processing views). 
4) Click on the User Descriptions Tab and select Copy to open Select Employee to Copy 

(see Appendix 49 – Select Employee to Copy). 
5) Select an employee from the drop-down list to view their user description list. 
6) Select one or more evidence descriptions to copy by using Ctrl-click.  
7) Click OK to add the evidence descriptions your list. 
8) Repeat steps 5-7 for any additional employee lists. 
9) Click Cancel to close Select Employee to Copy then click Save to close Evidence 

Descriptions. 

To select a description from a user defined list:  

1) In the Evidence Tab of the New Submission screen, click Add to open New Evidence. 
2) Select the Description button to open Select [Evidence] Description. 
3) Select the appropriate description from the list.  
4) Click the Select button to enter the selected description and close the dialog. 
5) Click Add to enter the evidence. 
6) Repeat steps 1-5 for any additional evidence entries. 

CHAIN OF CUSTODY 

FA maintains chain of custody for submissions, cases, case records, evidence and batches. 

To view chain of custody: 

1) Select the Case Processing module at the bottom of the Navigation Pane. 
2) Select My Work folder at top of the Navigation Pane or expand (click on > to left of 

folder) user’s primary lab and section folders to select My Case Records folder.  
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3) Select the appropriate case record from the Contents Pane. 
4) Double-click the case record or select Case Record Details from the Case Records 

grouping of the ribbon to open Case Record Details. 
5) Click the Chain of Custody icon ( ) on the toolbar or go to Actions > Case Record 

Chain of Custody in the menu bar to open Chain of Custody Details (see Figure 27 – 
Chain of Custody Details). 

To view chain of custody comments: 

1) In Chain of Custody Details, go to the View menu (see Appendix 50 - Chain of Custody 
Details View Menu) and select Include Comments. 

2) Expand each item to view all of the transfers. 
Note: Since comments can become large and unwieldy with numerous entries, the 
evidence list is collapsed each time Chain Of Custody Details is opened. Deselect 
Include Comments to automatically expand the evidence list when Chain Of 
Custody Details is opened. 

CHAIN OF CUSTODY DETAILS 
Chain of Custody Details (see Figure 27 – Chain of Custody Details) lists the chain of custody 
transactions involving the selected evidence. Each entry in a piece of evidence’s chain of 
custody indicates a physical transfer of the evidence. 

 
Figure 27 – Chain of Custody Details 
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Table 20 – Chain of Custody Details Options 
Icon Option Effect 

 
Print Chain of 
Custody 

Opens Chain of Custody Report dialog to select a printer and 
format in which to print the details for the selected chain of 
custody. 

 
Print Preview Opens Default Report Settings dialog to choose a format in 

which to preview the selected chain of custody report. 

 
Show Evidence Toggles visibility of the Evidence grid to show the list of 

evidence for the selected chain of custody. 

 
Auto Width Sets the width of the column to automatically fill the entire width 

of the grid. 

 
Open Case Chain 
of Custody 

Opens Chain of Custody Details for the selected case. 

 
Open Submission 
Chain of Custody 

Opens Chain of Custody Details for the selected submission. 

 
Open Evidence 
Chain of Custody 

Opens Chain of Custody Details for the selected evidence. 

 
Open Batch Chain 
of Custody 

Opens Chain of Custody Details for the selected batch. 

MY PERSONAL CUSTODY VIEW 

My Personal Custody View in the Evidence module displays all evidence in the personal 
custody of the logged in user.  
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Figure 28 – My Personal Custody View 

Table 21 – My Personal Custody Ribbon Options 
Grouping Option Effect 

File Open Opens Evidence Details for the selected 
evidence (see Appendix 24 – Evidence Details). 

Content Refresh Updates the Contents Pane with any new entries.

Cases Case Details Opens Case Details for the case assigned to the 
selected evidence. 

Evidence 

Evidence Details Opens Evidence Details for the selected 
evidence (see Appendix 24 – Evidence Details). 

Open Selection Opens Batch Details for the selected evidence. 

Assign Evidence Opens Assign Evidence to Exams to assign 
selected evidence to one or more exams and 
associated case records. 

Transfer Evidence Opens Transfer Evidence to transfer selected 
evidence to another lab, section, or examiner. 

Request Lockbox 
Transfer 

Opens Lockbox Transfer Request to request a 
lockbox transfer for the selected evidence (see 



Forensic Advantage Systems  Forensic Laboratory User Guide 

Version 15.1  Page 60 of 165 

Grouping Option Effect 

Appendix 52 – Lockbox Transfer Request). 

Add Items to 
Batch 

Opens Add Evidence to Batch to add the 
selected evidence to a new or existing batch (see 
Appendix 51 – Add Evidence to Batch). 

Evidence 
Inventory 

Opens Evidence Inventory for evidence listed in 
Contents Pane, with option to print (see 
Appendix 53 – Evidence Inventory). 

Object Repository 

Open Dept 
Objects 

Opens Object Repository to view/manage objects 
for the entire department/lab section. 

Open Case 
Objects 

Opens Object Repository – [Case #] to 
view/manage objects for the case associated 
with the selected evidence. 

Open Evidence 
Objects 

Opens Object Repository to view/manage objects 
associated with the selected evidence. 

Options Item Descriptions Opens Evidence Descriptions to add, change, 
delete, or copy evidence descriptions (see Figure 
26 – Evidence Descriptions). 

Submissions New Submission Opens New-Submission Entry form to start a new 
submission. 

To transfer evidence from My Personal Custody View: 

1) Select the Evidence module at the bottom of the Navigation Pane. 
2) Expand (click on > to left of folder) user’s primary lab and section folders to select My 

Personal Custody folder.  
3) Select a case, or cases, from the Contents Pane (select the plus sign next to a case 

number to see all items of evidence for that case). 
4) Select Transfer Evidence from the Evidence grouping of the ribbon. 
5) Use Select All, Select None, or checkboxes to select items for transfer. 
6) Select appropriate Transfer Reason and Transfer Type. 
7) Select destination for evidence.  

Note: Defaults to personal custody, select Place in Storage checkbox to select a 
storage location. 

8) Choose witnesses from the drop-down lists, if needed. 
9) Select Split checkbox to record separate transfers for each case, if needed.  
10) Select Transfer to transfer the selected evidence to the specified location. 
11) Repeat steps 5-10 for any remaining evidence. 
12) When complete, select OK to commit the evidence transfer(s). 
13) Confirm transfer by entering password (login credentials).  

Note: If witnesses are selected, their credentials are also required in order to 
complete the transfer. 
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EVIDENCE INVENTORY 
Evidence inventory, available in the ribbon of My Personal Custody View, provides a listing of all 
evidence items in a section including subitems. This listing can then be printed. Evidence 
inventory function can be used with a scanner to facilitate audits of locations. Management 
reports detail personal possession. 

BATCHES 

Transferring evidence can be made more convenient by creating batches. Batches are logical 
groupings of evidence that may be created and subsequently transferred together. The 
evidence in a batch may come from various cases/case records; however, in order for the batch 
to be transferred together, the evidence must be in the same location. 

To create a batch of evidence: 

1) Select the Evidence module at the bottom of the Navigation Pane. 
2) Expand (click on > to left of folder) user’s primary lab and section folders to select My 

Personal Custody folder.  
3) Highlight items in the Contents Pane to place in the batch (Use CTRL-click to select one 

at a time. Use Shift-click to select a group.) 
4) Select Add Items to Batch from the ribbon to open Add Evidence to Batch (see 

Appendix 51 – Add Evidence to Batch) 
5) Add the evidence to a new batch by selecting <new batch>. 
6) Type a name for the batch and then select OK. 
7) Add the evidence to a previous batch by selecting the name of the previous batch and 

then select OK. 

BATCHES VIEW 
In the Navigation Pane under each laboratory is a Batches folder to aid in finding and using 
created batches. 
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Figure 29 – Batches View 

Table 22 – Batches View Ribbon Options 
Grouping Option Effect 

Batches 

Open Batch Opens Batch Details for the selected batch. 

Rename Batch Opens Choose Batch Name to modify the name 
of the selected batch (see Appendix 54 – Choose 
Batch Name). 

Transfer Batch Opens Transfer Evidence for the selected batch. 

Renew Batch Updates expiration date for selected batch. 

Print Batch Opens dialog to select print options for selected 
batch. 

Delete Batch Deletes selected batch and associated evidence. 

Evidence 
Evidence Details Opens Evidence Details for selected evidence. 

Case Details Opens Case Details for case associated with 
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Grouping Option Effect 

selected evidence. 

Transfer Selected 
Evidence 

Opens Transfer Evidence for selected evidence. 

Remove Items 
from Batch 

Removes the selected evidence from the batch. 

Refresh Evidence Updates Evidence grid with any recent changes. 

To transfer a batch of evidence from Batches View: 

1) Select the Evidence module at the bottom of the Navigation Pane. 
2) Expand (click on > to left of folder) user’s primary lab and section folders to select My 

Personal Custody folder.  
3) To transfer the complete batch at once: 

a. Select the appropriate batch from the Batches grid of the Contents Pane. 
b. Select Transfer Batch from the Batches grouping of the ribbon. 

4) To transfer select items from a batch: 
a. Select the appropriate batch in the Batches grid of the Contents Pane. 
b. Select the appropriate items of evidence from the Evidence grid at the bottom of the 

Contents Pane. 
c. Select Transfer Selected Evidence from the Evidence grouping of the ribbon. 

BATCH DETAILS 
Batch Details form provides access to general information about any batch created for 
transferring evidence. See Table 23 – Batch Details Ribbon Options for descriptions of the 
ribbon menu options available in Batch Details. 
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Figure 30 – Batch Details 

Table 23 – Batch Details Ribbon Options 
Grouping Option Effect 

Actions Print Click arrow to view available print options.

Details 

Evidence Opens Evidence Details for the selected 
evidence. 

Case Opens Case Details for the case 
associated with the selected evidence. 
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Grouping Option Effect 

Transfers 

Transfer Opens Transfer Evidence for the selected 
evidence. 

Transfer (w/children) Opens Transfer Evidence for the selected 
parent evidence and all associated child 
evidence. 

Manage 

Remove from Batch Removes selected evidence from the 
batch. 

Add to Batch Opens Add Evidence to Batch to create a 
new batch from selected evidence. 

Verify Evidence Marks selected evidence as verified. 

Add to Container(s) Opens New Evidence to designate 
container for selected evidence. 

View 

Expand All Expands all parent evidence to display 
child evidence. 

Collapse All Collapses all parent evidence to hide 
child evidence. 

Reset View Resets view to original settings. 

Working with Cases 
Once submission data has been processed, cases for the sections responsible for the 
requested examinations are automatically created. The Case Processing module is leveraged 
by examiners to perform their job in a timely, effective and consistent fashion. 

MY WORK VIEW 

My Work View, in the Case Processing module (see Figure 5 – My Work View) displays all the 
cases to which the logged in user is assigned as an examiner. See below for the main functions 
accessible through the ribbon menu of My Work View.  

 
Figure 31 – My Work View Ribbon Options 

Table 24 – My Work View Ribbon Menu Options 
Grouping Option Effect 
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Grouping Option Effect 

File 

Open Opens Case Record Details for the selected case 
record. 

Delete Opens Delete/Terminate Case Record with 
options to delete or terminate the selected case 
record (see Appendix 43 – Delete Terminate 
Case Record). 

Content Refresh Updates the Contents Pane with any recent 
changes. 

Analysis Add Resources Opens Worksheet Resource Assignment to add 
resource(s) to one or more worksheets for the 
selected case record (see Appendix 44 – 
Worksheet Resource Assignment). 

Case Records 

Case Record 
Details 

Opens Case Record Details for the selected case 
record. 

Assign Evidence Opens Assign Evidence to Exams for the 
selected case record (see Appendix 23 – Assign 
Evidence to Exams). 

View Reviews Opens Review Management to view the reviews 
for the selected case record (see Appendix 30 – 
Review Management). 

Request Reviews Opens Review Details for the selected case 
record to request a review and add reviewers 
(see Figure 46 – Review Details-Details Tab). 

Transfer Case 
Record 

Opens Transfer/Assign Case Record to transfer 
the selected case record to a specified lab and 
examiner (see Appendix 45 – Transfer/Assign 
Case Records). 

Release Report Releases the lab report for the selected case 
record. 

Prepare Batch  Opens Prepare Batch Processing File to select 
evidence and resources for batch export (see 
Appendix 46 – Prepare Batch Processing File).  

Import Batch 
Results 

Opens Import Batch Processing Results to select 
a batch processing file and import results to FA 
(see Appendix 47 – Import Batch Processing 
Results). 

Cases Case Details Opens Case Details for the selected case record. 
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Grouping Option Effect 

Case Report Opens Preview for full case report of selected 
case record. 

Object Repository 

Open Dept 
Objects 

Opens Object Repository to view/manage objects 
for the entire department/lab section. 

Open Case 
Objects 

Opens Object Repository – [Case #] to 
view/manage objects for the case associated 
with the selected evidence. 

Open Case 
Record Objects 

Opens Object Repository – [Case Record #] to 
view/manage objects for the selected case 
record. 

Options Item Descriptions Opens Evidence Descriptions to add, change, 
delete, or copy evidence descriptions (see Figure 
26 – Evidence Descriptions). 

MY MESSAGES 

My Messages is a method of communication about a specific case record between examiners. 
By selecting an option from the Message grouping of the ribbon, you can create a new 
message, archive a message, mark a message as complete, open the case record associated 
with a message, open any attachments associated with a message or forward a message to 
another individual. When a message is received, a banner near the bottom right of the screen 
appears advising the individual of a new message. 
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Figure 32 – Message 

To create a new message: 

1) Select the Case Processing module 
2) Select My Messages folder in the Navigation Pane to load My Messages View 
3) Select New from the Message grouping of the ribbon menu to open Message (see 

Figure 32 – Message). 
4) Select a recipient for the message from the drop-down choices (if a name is in brackets, 

that individual is not an active user in the system). 
5) Enter a Case Record # in the following format: 2012-0001-1 (2012-0001 is the Case/Lab 

Number and -1 is the Record #). 
6) Enter a subject, a message, and Attach File, if applicable.  
7) Select Send from the ribbon menu. 

SEARCH MESSAGES VIEW 
Search Messages View, in the Case Processing module, allows you to search for messages 
based on selected criteria. Ribbon menu options allow you to manage the messages and open 
the case record associated with the messages in order to view or work on a specific case. 
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Figure 33 – Search Messages View 

To search archived messages: 

1) Select the Search Messages node under the My Messages node in the Navigation 
Pane. 

2) Enter related search criteria and click Search. 

COMMUNICATION LOG 

Communication log is a method to record communication for a particular case or case record. 
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Figure 34 – Communication Log 

Table 25 – Communication Log Ribbon Options 
Grouping Option Effect 

New 

Thread Opens New Communication Log Entry to create 
a new communication thread (see Appendix 29 – 
New Communication Log Entry). 

Reply Opens New Communication Log Entry to create 
a new reply on the selected thread.  

Edit 
Delete Deletes the selected communication. 

Open Opens the selected communication log entry. 

View Toggle Comments Toggles visibility of in-line comments for 
communication log entries. 

Print 

Default Print Prints the communication log with the default 
settings. 

Print… Opens Communication Log Report dialog to 
select printer and format settings. 

Preview Opens dialog to select format in which to preview 
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the communication log report. 

Documents & 
Reports 

Opens Generate Document dialog to select a 
template for printing a document or report related 
to the case/case record. 

To add communication specific to a case or case record: 

1) Select the Case Processing module at the bottom of the Navigation Pane. 
2) Select My Work folder at top of the Navigation Pane or expand (click on > to left of 

folder) user’s primary lab and section folders to select My Case Records folder.  
3) Select the appropriate case from the Contents Pane. 
4) Select Case Details from the Cases grouping of the ribbon to open Case Details or 

select Case Record Details from the Case Records grouping of the ribbon to open 
Case Record Details. 

5) Click the Communication Log icon ( ) in the toolbar or go to Actions > 
Communication Log in the menu bar to open Communication Log (see Figure 34 – 
Communication Log). 

6) Select New Thread from the ribbon to open New Communication Log Entry (see 
Appendix 29 – New Communication Log Entry). 

7) Enter the appropriate communication information and then select Save & Close or Save 
& Notify. 

8) Click the red x in the upper right corner to close the Communication Log and return to 
Case Details or Case Record Details. 

CASE DATES AND TIMES 

The status of a case is dependent on certain actions performed. The case status also 
determines what actions can or cannot be performed on the case. 

Table 26 - Case Status Descriptions 
Case Status Description 

Submitted Date and time when the first submission of the case was received. 

In Section Date and time when the evidence associated with the case came into 
the designated section or an examiner’s personal custody. 

Assigned Date and time when the case record was assigned. 

Exams Started Date and time when the exam Analysis Forms were initiated for the 
case record. 

Exams Completed Date and time when the most recent Analysis Form was submitted. 

Due Date Optional field in which a due date can be set for the case record. 

Completed Date and time when the lab report was released. 
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CASE RECORD DETAILS 

Case Record Details consists of tabbed information for Details, Requested Exams, Analysis 
Forms, Lab Reports, Specimen Count, Transfer History, and Extended Data. Click on each tab 
to enter or access the information. 

DETAILS TAB 
The Details Tab of Case Record Details contains all of the general information for the case 
record, including information about the associated case. 

 
Figure 35 – Case Record Details - Details Tab 

REQUESTED EXAMS TAB 
The Requested Exams Tab of Case Record Details displays exams requested in submission 
entry. May Add or Remove available exams as well as assign evidence to requested exams. 
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Figure 36 – Case Record Details - Requested Exams Tab 

ANALYSIS TAB 
The Analysis Tab of Case Record Details provides access to the analysis forms configured for 
the lab section. See Analysis User Interface section for details on the Analysis User Interface 
and instructions for entering exam results. 
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Figure 37 – Case Record Details - Analysis Tab 

FINAL REPORT TAB 
The Final Report Tab of Case Record Details displays any generated lab reports. A lab report 
may not be created until all examinations are complete. The automated reports display any 
results statements generated in the analysis forms during examination result entry. See Step 7: 
Report Generation for instructions on creating a final report. 
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Figure 38 – Case Record Details – Final Report Tab 

SPECIMEN COUNT TAB 
The Specimen Count Tab of Case Record Details automatically populates based on any 
associated specimen count fields entered in the analysis form(s) during results entry. 
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Figure 39 – Case Record Details – Specimen Count Tab 

TRANSFER HISTORY TAB 
The Transfer History Tab of Case Record Details displays case record assignments as well as 
any case record transfer information. 
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Figure 40 – Case Record Details – Transfer History Tab 

To transfer a case record: 

1) Select the Case Processing module at the bottom of the Navigation Pane. 
2) Select My Work folder at top of the Navigation Pane or expand (click on > to left of 

folder) user’s primary lab and section folders to select My Case Records folder.  
3) Select the appropriate case from the Contents Pane. 
4) Select Transfer Case Record from the Case Records grouping of the ribbon to open 

Transfer/Assign Case Record (see Appendix 45 – Transfer/Assign Case Records). 
5) Verify Lab selection and select Reason for transfer. 
6) Select checkbox to request a lockbox transfer for evidence, if needed. 

Note: If checkbox is selected, Dept and Reason for evidence transfer will be 
activated and required. 

7) Enter any comments, if needed. 
8) Click OK. 

EXTENDED DATA TAB 
The Extended Data Tab of Case Record Details captures any client specific information related 
to the case record. 
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Figure 41 – Extended Data Tab 

CASE RECORD ASSIGNMENT 

Forensic Advantage offers several different methods for assigning case records. See the table 
below for details on the available assignment types. FA Administrators may configure the 
appropriate case record assignment types for each lab section. 

Table 27 – Case Record Assignment Types 
Type Description 

Supervisor Assignment Supervisors assign case records to analysts. 

Self-Assignment Analysts assign case records to themselves. 

Custody Assignment System assigns case records to analysts when evidence 
associated with the case record is transferred into an analyst’s 
personal custody. 

Rotational Assignment System assigns case records to analysts on a rotational basis, 
as specified per section. 

Available Assignment System assigns case records to analysts with least number of 
active case records currently assigned. 
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Type Description 

Subsequent Assignment System assigns case records in subsequent submissions to 
analysts who handled the case record in original submission. 

CASE RECORD SEARCH 

Case Record Search View facilitates searches based on laboratory, department, status, and 
examiner. For more advanced criteria, use the FA Search function (see Figure 43 – FA Search 
– Evidence Tab). 

 
Figure 42 – Case Record Search View 

FA SEARCH 

FA Search form facilitates searches based on advanced criteria pertaining to cases, parties of 
interest, case records, evidence, and communication log entries. See Figure 43 – FA Search – 
Evidence Tab for available evidence search criteria. 
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Figure 43 – FA Search – Evidence Tab 

RELATED CASES 

Relating cases could be beneficial if the requestor wants to compare an item(s) of evidence 
from one case to an item(s) of evidence from another case(s). It allows the analyst to report 
results from items of evidence associated with different case numbers. Relating cases does not 
close the case record for the related case even if the evidence is worked in the other case. The 
other case has to be completed with a report, administratively closed, or the case terminated. 

Once a case is related, the evidence from the related case has to be assigned to an exam in 
order to be included in the original case record’s analysis form. 

To relate cases: 

1) Select either the Evidence module or the Case Processing module in the Navigation 
Pane. 

2) Select Case Details from the Cases grouping of the ribbon or use the Go to Case # icon 

( ) in the upper right corner to open Case Details for the appropriate case. 
3) Select the Related Cases Tab. 

4) Click on the Add Related Case icon ( ) in the toolbar or go to Actions > Add Related 
Case in the menu bar. 
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5) Enter or select the Case # for the related case and click OK. 
Note: Related Case # will appear in the Related Cases grid. 

CONFIDENTIAL CASES 

A case is hidden in the system once it is marked confidential. The only way to view a 
confidential case is if you know the Case/Lab Number. If the Case/Lab Number is lost, the case 
is lost from view in Forensic Advantage and would need to be accessed by the administrator. 

To mark a case confidential: 

1) Select either the Evidence module or the Case Processing module in the Navigation 
Pane. 

2) Select Case Details from the Cases grouping of the ribbon or use the Go to Case # icon 

( ) in the upper right corner to open Case Details for the appropriate case. 
3) Go to Actions > Mark Marked Sensitive in the menu bar and Marked Sensitive Access 

Tab appears. 

To grant confidential access: 

1) Select either the Evidence module or the Case Processing module in the Navigation 
Pane. 

2) Select Case Details from the Cases grouping of the ribbon or use the Go to Case # icon 

( ) in the upper right corner to open Case Details for the appropriate case. 
3) Go to Actions > Grant Marked Sensitive Access to Employee in the menu bar to 

open Select User dialog. 
4) Select an employee from the drop-down list and click OK. 
5) Marked Sensitive Access Tab displays list of employees with access to confidential 

case. 

To access confidential cases: 

1) Select either the Evidence module or the Case Processing module in the Navigation 
Pane. 

2) Use the Go to Case # icon ( ) and enter the Lab/Case # for the Marked Sensitive case 
and click OK to open Case Details. 

DO NOT DESTROY 

Do Not Destroy is a flag that can be set on a case to signify that evidence belonging to that case 
should not be disposed. Adding or removing this flag can be done from the Actions menu of 
Case Details and the event is recorded in the case’s Do Not Destroy History. Do Not Destroy 
status displays in the status bar of Case Details. 

REVIEW MANAGEMENT 

Reviews View displays all of the reviews assigned to you and your cases pending review. May 
also expand Case Record Reviews node to see Reviews of My Case Records, Awaiting My 
Review and Being Reviewed by me nodes. 
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REVIEWS VIEW 
To see all of the reviews assigned to you or your cases pending review, select the Reviews 
node under your primary lab section. 

 
Figure 44 – Reviews View 

To complete a review: 

1) Select the Case Processing module at the bottom of the Navigation Pane. 
2) Expand (click on > to left of folder) user’s primary lab and section folders to select 

Reviews folder (see Figure 44 – Reviews View).  
3) Select the appropriate case record from the Contents Pane. 
4) Select Accept Review from the Review grouping of the ribbon or open Review Details 

and select Accept Review. 
5) Select Complete Review from the Review grouping of the ribbon or open Review 

Details and select Complete Review. 
Note: If you have not accepted the review yet, Accept Review opens (see Appendix 
55 – Accept Review) to accept the review and prevent others from starting it. 
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Figure 45 – Complete Review 

To pass a review: 

1) Select the appropriate response (yes, no, n/a) for each question 
2) Provide the appropriate feedback 
3) Select Pass to complete the review. 

To return and continue a review: 

1) Select the appropriate response (yes, no, n/a) for each question 
2) Provide the appropriate feedback  
3) Select Return. 

Note: Necessary changes need to be made and the review process has to be re-
started from the beginning. 

REVIEW DETAILS 
Review Details provides access to any reviews associated with a specific case record. See Step 
8: Review and Approval for details on requesting and completing reviews.  

Details Tab 
The Details Tab of Review Details displays general information about the case record to be 
reviewed. It also allows selection of the type of review to be performed. 
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Figure 46 – Review Details-Details Tab 

Reviewers Tab 
The Reviewers Tab of Review Details displays a list of all available reviewers. May Add or 
Remove reviewers from the review request list. 



Forensic Advantage Systems  Forensic Laboratory User Guide 

Version 15.1  Page 85 of 165 

 
Figure 47 – Review Details – Reviewers Tab 

Editing Reports 
To edit a report that has not been released, recreate the report. To edit a report that has been 
released, create an amended report. 

To edit a report that has not been released: 

1) Select the Case Processing module at the bottom of the Navigation Pane. 
2) Select My Work folder at top of the Navigation Pane or expand (click on > to left of 

folder) user’s primary lab and section folders to select My Case Records folder.  
3) Select the appropriate case from the Contents Pane. 
4) Double click the case or select Case Record Details from the Case Records grouping 

of the ribbon to open Case Record Details. 
5) Click on the Final Report Tab and highlight the appropriate report in the grid.  

6) Click the Cancel Final Report icon ( ) in the toolbar or go to Final Report > Cancel 
Final Report in the menu bar. 

7) Select Yes on the Delete Confirmation dialog and Status will change to Canceled. 
8) Click Save and Close in Case Record Details. 
9) Select case in Contents Pane, if needed, and select Case Details from the Cases 

grouping of the ribbon to open Case Details. 
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10) Click on the Submissions Tab and double-click the relevant (or only) submission to open 
Submission Details. 

11) Change the needed information, then click Save & Close. 
12) Click on the Case Records Tab and double-click the appropriate case record or go to 

Case Records > Open Case Record Details to re-open Case Record Details. 
13) Create a new report with the updated content (see Step 7: Report Generation). 

To create an amended report: 

1) Select the Case Processing module at the bottom of the Navigation Pane. 
2) Select My Work folder at top of the Navigation Pane or expand (click on > to left of 

folder) user’s primary lab and section folders to select Completed folder.  
3) Select the appropriate case from the Contents Pane. 
4) Double click the case or select Case Record Details from the Case Records grouping 

of the ribbon to open Case Record Details. 
5) Open the appropriate Case Record Details. 
6) Click on the Final Report Tab. 
7) Select Amend Case Record from the toolbar or go to Actions > Amend Case Record 

in the menu bar. 
8) Select Yes on the Proceed? dialog (see Appendix 56 – Amended Report – Proceed?). 
9) Go to Reports > New Final Report in the menu bar or click the New Final Report icon (

) in the toolbar and Generate Report – AMENDED REPORT opens (see Appendix 57 
– Generate Report – AMENDED REPORT). 

10) Click on the Details Tab and select the appropriate information to Show in the report. 
11) Click on the Amended Tab and select the Report Purpose from the drop-down menu. 

a. If ‘(Use my own statement)’ is selected: 
i. Enter appropriate description in the Summary Preview text box. 
ii. Select Apply. 

b. If ‘Non-result section: Correcting the spelling’ is selected: 
i. Select Subject’s name, Victim’s name, or Suspect’s name from the Item to be 

Corrected drop-down. 
ii. Enter the Requested by, On, and Requesting Agency information to auto-

populate statement in the Summary Preview. 
Note: To modify the auto-populated statement, select Edit, make any 
necessary changes, then select Apply. 

c. If ‘Result section: Correcting the paragraph’ is selected: 
i. Enter the Paragraph/Line# and On Page Number information to auto-populate 

statement in the Summary Preview. 
Note: To modify the auto-populated statement, select Edit, make any 
necessary changes, then select Apply. 

d. If ‘Result section: Correcting the line(s) of chart’ is selected: 
i. Enter the Paragraph/Line# and On Page Number information to auto-populate 

statement in the Summary Preview. 
Note: To modify the auto-populated statement, select Edit, make any 
necessary changes, then select Apply. 

e. If ‘Adding information’ is selected: 
i. Select Subject’s name, Victim’s name, or Suspect’s name from the Item to be 

Corrected drop-down. 
ii. Enter a description of the Item To Be Corrected in the available text box. 
iii. Enter the Requested by, On, and Requesting Agency information to auto-

populate statement in the Summary Preview. 
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Note: To modify the auto-populated statement, select Edit, make any 
necessary changes, then select Apply. 

12) Select Create to generate an Amended Report with Draft status.  
Note: Need to go through the appropriate review process before it can be released 
(see Step 8: Review and Approval). 

Subsequent Submissions 
After evidence is received, the submission is complete and will no longer be seen in New 
Submissions View. However, new evidence may come in for a previous submission or a new 
exam may be required for a piece of evidence. In such cases, create a subsequent submission. 
Subsequent submissions retain a portion of the information from the original submission in the 
General, Victim and Parties of Interest Tabs. In order to complete a subsequent submission, a 
requested exam must be added.  

When entering data in a new submission, the system automatically searches the Agency Case 
# to determine if there are any previous requests. If the Agency Case # has previously been 
entered into the system, a search window will appear listing all of the cases associated with the 
Agency Case #. 

To enter a subsequent submission: 

1) Select the Evidence module and navigate to New Submissions View (under user’s 
primary lab) in the Navigation Pane. 

2) Select New from the File grouping of the ribbon menu or select New Submission from 
the Submissions grouping of the ribbon menu. 

3) New Submission screen opens (see Figure 7 – New Submission Details Tab). 
4) Select Search from the File grouping of the ribbon to open Search at the Case Tab (see 

Appendix 10 – Search). 
5) Enter any known data in the appropriate fields and click Search. 
6) Highlight the appropriate record in the results grid and click Select to open New 

Subsequent Submission for the associated Lab #. 
7) Click on the Officers Tab to add Investigating and/or Submitting officers for the 

subsequent submission. 
8) Click on the Exams Tab and Add one or more requested exams. 

Note: If the new requested exam is the same type as an existing exam and a report 
has not been generated, the newly requested exam should be added to the 
existing case record. If the new requested exam is the same type as an existing 
exam and a report has been generated, the newly requested exam will be added to 
a new case record. 

9) Click on the Evidence Tab to Add or Resubmit one or more items of evidence for the 
subsequent submission. 
Note: If an item previously entered into the system has not been returned to the 
submitting agency, it will not be available for resubmission. 

10) Enter any additional information for the subsequent submission and then click Submit. 
11) Follow the rest of the workflow process to complete the case (see Workflow). 

RESUBMITTING EVIDENCE 

Evidence items associated with a particular case must be re-submitted for subsequent 
submissions if the evidence has been received and returned to the submitting agency. Evidence 
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cannot be re-submitted if the item of evidence was never received or if the evidence has not yet 
been returned. 

To resubmit evidence in the New Submission screen: 

1) Click on the Evidence Tab and select Resubmit. 
2) Select the evidence to resubmit and click OK. 

Note: Click checkbox to include children of the item/container. 

To resubmit evidence in Case Details: 

1) Select the Evidence or Case Processing module in the Navigation Pane, select the 
appropriate case in the Contents Pane and click Case Details in the ribbon to open 
Case Details. 

2) Go to Evidence > Resubmit Evidence in the menu bar or click the Resubmit Evidence 

icon ( ) in the ribbon.  
3) Select the evidence to resubmit and click OK. 

Note: Click checkbox to include children of the item 

Testimony Module 
The Testimony module provides a means to record, display and print information about 
subpoenas received by employees of the lab. In addition, employees who testify are provided 
the ability to record and display information about their testimony hours and mileage. This 
information can then be used to produce Court Testimony Statistics for the lab. 

MY SUBPOENAS VIEW 

My Subpoenas View displays all subpoenas entered for the employee currently logged in to 
Forensic Advantage. See Table 28 – Subpoenas View Ribbon Options for descriptions of the 
available ribbon menu options.  
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Figure 48 – My Subpoenas View 

Table 28 – Subpoenas View Ribbon Options 
Grouping Option Effect 

File 

New Opens Subpoena Details to enter subpoena 
information. 

Open Opens Subpoena Details for the selected 
subpoena. 

Delete Deletes the selected subpoena. 

Content Refresh Updates the Contents Pane with any recent 
changes. 

Case Details Open Case Details Opens Case Details for the case associated with 
the selected subpoena. 

Court Appearance New Court 
Appearance 

Opens Court Appearance to add a court 
appearance for the selected subpoena. 
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SUBPOENAS 

Once a subpoena is entered, an email will be sent to the employee receiving the subpoena. To 
create, add the information associated with the subpoena to your Outlook calendar, open the 
attachment in the email and click Save and Close. 

 
Figure 49 – Subpoena Details 

To add a subpoena: 

1) Select the Testimony module and click on My Subpoenas node at the top of the 
Navigation Pane, if needed. 

2) Select New in the File grouping of the ribbon to open Subpoena Details. 
3) Select or enter available information into Subpoena Details form. 
4) Click Add to enter lab/case #s associated with the subpoena. 
5) Click on the Defendants Tab. 
6) Choose Select…to view persons of interest associated with the related lab/case #. 
7) Choose New to add a person of interest to the subpoena. 
8) Click Save & Close to enter the subpoena information and close Subpoena Details. 

COURT APPEARANCES 

Court Appearance form (see Figure 50 – Court Appearance) contains details about any entered 
court appearances. May also log court time and related expenses. 
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Figure 50 – Court Appearance 

To add a new court appearance: 

1) Select the Testimony module and click on My Subpoenas folder 
2) Click New Court Appearance in the ribbon. 

Note: Court and Subpoena Employee are Read only, populated from selected 
subpoena. 

3) Select appropriate Subpoena Disposition and enter any related hours or miles, if 
needed. 

4) Click Save and Close when complete. 

Activity Logging 
Activity that needs to be tracked relating to an individual is entered into the Activity Logging 
module. Recent activity, all activity or select activity can be viewed by selecting the appropriate 
option located in the ribbon menu. 
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Figure 51 – My Recent Activity View 

Table 29 – Activity Logging Ribbon Options 
Grouping Option Effect 

Contents Refresh Updates the Contents Pane with any recent 
changes. 

Activity 

New Entry Opens Activity Log Entry to enter a new log entry 
(see Figure 52 – Activity Log Entry). 

Edit Entry Opens Activity Log Entry to modify the details of 
the selected entry. 

Delete Entry Deletes the selected activity log entry. 

Approve Entries Marks selected entries as approved. 

Unapprove 
Entries 

Marks selected entries ad unapproved. 
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To add an activity log entry: 

1) Select the Activity Logging module from the bottom of the Navigation Pane. 
2) Select New Entry from the Activity grouping of the ribbon menu. 
3) If the activity is associated with a case record then be sure to input the activity through 

the case record: 
a. Select the Case Processing module at the bottom of the Navigation Pane. 
b. Select My Work folder at top of the Navigation Pane or expand (click on > to left of 

folder) user’s primary lab and section folders to select My Case Records folder.  
c. Select the appropriate case from the Contents Pane. 
d. Double-click the case or select Case Record Details from the Case Records 

grouping of the ribbon to open Case Record Details. 

e. Select the Activity Icon ( ) from the ribbon to open Activities. 
f. Select New Activity in the ribbon to open Activity Log Entry. 

4) Select the appropriate Agency. 
5) Enter a description, if appropriate. 
6) Enter the Start Date, Duration, and End Date. 
7) Select a Category (e.g. Project, Grant, Casework, Administrative, Court, Tour, Media, 

Presentation, Crime Scene Support, Quality Review). 
8) Select an Activity Type (e.g. Training, Development, Research, Examination, Public 

Relations, Technical Review, Review, Testimony, Processing). 
9) Select a Task Type (e.g. Preparation, Attending, Administrative, Testing, Time Entry, 

Travel, Waiting, Testify, Technical, Teaching, Tour, etc.). 
10) Use checkboxes to mark Billable or Overtime, if applicable. 
11) Click OK to save the activity log entry. 
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Figure 52 – Activity Log Entry 

Reference Library 
The Reference Library module provides a means to record and keep track of the many 
reference books a forensic science laboratory owns. In addition to the normal library functions of 
check-out and return, the module provides the ability to search for books by subject, title, author 
and location. 

BOOKS  

Books View in the Reference Library module displays all books entered into the system. See 
Table 30 – Reference Library Ribbon Options for available ribbon menu options. 



Forensic Advantage Systems  Forensic Laboratory User Guide 

Version 15.1  Page 95 of 165 

 
Figure 53 – Books View 

Table 30 – Reference Library Ribbon Options 
Grouping Option Effect 

File 

New Opens Book Details to enter information for a 
new book (see Figure 54 – Book Details). 

Open Opens Book Details for the selected entry. 

Delete Deletes the selected book entry. 

Content Refresh Updates the Contents Pane with any recent 
changes. 

Authors New Author Opens Author Details to enter information for a 
new author (see Figure 57 – Author Details). 

Books Return Book Marks selected book as On Shelf. 
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BOOK DETAILS 
Book Details contains all general information about a book as well as all associated checkout 
information. See Checkout and Return section for details on how to checkout and return books. 

 
Figure 54 – Book Details 

Table 31 – Book Details - Book Tab Options 
Grouping Option Effect 

Authors 

Add Opens Add Author to select an author to add to 
the book. 

Change Opens Change Author to select a different author 
for the book.  

Remove Removes the selected author from the book. 

Subjects 

Add Opens Add Subject to select a subject to 
associate with the book. 

Change Opens Change Subject to select a different 
subject to associate with the book. 
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Grouping Option Effect 

Remove Removes the selected subject from the book. 

To enter a book into the reference library: 

1) Select Reference Library module from the bottom of the Navigation Pane and select the 
Books node at the top of the Navigation Pane. 

2) Select New from the File grouping of the ribbon menu to open Book Details (see Figure 
54 – Book Details). 

3) Enter as much information in the Book Tab as possible.  
Note: Title, Author, Subject, and Location are required. 

4) Click Save and Close to save the information and close the form. 

CHECKOUT AND RETURN 
The Checkout Information Tab of Book Details facilitates the normal library functions of 
checkout and return. 

 
Figure 55 – Book Details - Checkout History Tab 

To check out a book: 

1) Select the appropriate book in the Contents Pane. 
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2) Select Open from the File grouping of the ribbon menu to open Book Details. 
3) Select the Checkout Information Tab. 
4) Enter First Name, Last Name, Checkout Date and Due Date. 

5) Select the Check Out icon ( ) from the toolbar or select Actions > Checkout from the 
menu bar. 

6) Select Save and Close. 

To return a book: 

1) Select the appropriate book in the Contents Pane. 
2) Select Open from the File grouping of the ribbon menu to open Book Details. 
3) Select the Checkout Information Tab. 
4) Enter or select the Return Date. 

5) Select the Return icon ( ) from the toolbar or select Actions > Return from the menu 
bar. 

6) Select Save and Close. 

To mark a book lost: 

1) Select the appropriate book in the Contents Pane. 
2) Select Open from the File grouping of the ribbon menu to open Book Details. 

3) Select the Mark Lost icon ( ) from the toolbar or select Actions > Mark Lost from the 
menu bar. 

4) Select Save and Close. 

To mark a book found: 

1) Select the appropriate book in the Contents Pane. 
2) Select Open from the File grouping of the ribbon menu to open Book Details. 

3) Select the Mark Found icon ( ) from the toolbar or select Actions > Mark Found from 
the menu bar. 

4) Select Save and Close. 

AUTHORS 

Authors View in the Reference Library module displays all authors entered into the system. See 
Table 32 – Authors View Ribbon Options for details about available ribbon menu options. 
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Figure 56 – Authors View 

Table 32 – Authors View Ribbon Options 
Grouping Option Effect 

File 

New Opens Author Details to enter information for a 
new author. 

Open Opens Author Details to view or modify 
information for the selected author. 

Delete Deletes the selected author. 

Contents Refresh Updates the Contents Pane with any recent 
changes. 

Authors 

New Author Opens Author Details to enter information for a 
new author. 

Open Author 
Details 

Opens Author Details to view or modify 
information for the selected author. 
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Grouping Option Effect 

Delete Author Deletes the selected author. 

AUTHOR DETAILS 
Author Details captures information for authors of any reference materials entered in the 
Reference Library. 

 
Figure 57 – Author Details 

To add a new author: 

1) Select the Reference Library module and click on the Authors node at the top of the 
Navigation Pane. 

2) Select New or New Author from the ribbon menu to open Author Details (see Figure 57 
– Author Details). 

3) Enter all available information.  
Note: Last Name and Display Name are required; Author ID is automatically 
assigned. 

4) Select Save and Close. 

SUBJECTS 

Subjects View in the Reference Library module provides direct data entry in the Contents Pane. 
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Figure 58 – Subjects View 

To add a new subject: 

1) Select the Reference Library module and click on the Subjects node at the top of the 
Navigation Pane. 

2) Click in the Contents Pane where it says “Click here to add a new row” (see Figure 58 – 
Subjects View). 

3) Enter a unique Code and Description for the subject and select the Active checkbox, if 
needed, to make it active in the system. 

4) Click Save Changes in the Common grouping of the ribbon to add the subject to the 
system.  

Firearms Reference Collection 
The Firearms Collection module provides a means to record, inventory and locate firearms in 
each laboratory’s reference collection. There are functions to enter firearms, print inventory 
listings and display information about firearms matching specified criteria. 
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NAVIGATION PANE 

The user interface of the Firearms Collection module is slightly different from other FA modules. 
Nodes in the Navigation Pane are organized by Active Firearms and Inactive Firearms. Each of 
these sections can still be separated according to laboratory by expanding the node and 
selecting the desired laboratory location. There are numerous ways to sort the information in the 
Contents Pane as well. See Customizing Your Workspace for descriptions of the various 
options. Also available in this module is a Firearms Search node. 

ACTIVE FIREARMS VIEW 

The following sections describe unique features in the Navigation Pane and Contents Pane of 
the Firearms Collection module. 

 
Figure 59 – Firearms Collection – Active Firearms View 

Table 33 - Active Firearms View Ribbon Options 
Grouping Option Effect 
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Grouping Option Effect 

File 

New Opens Firearm Details to enter information for a 
new firearm (see Figure 60 – Firearm Details - 
Details Tab). 

Open Opens Firearm Details to view or modify details 
of the selected firearm. 

Delete Deletes the selected firearm. 

Contents Refresh Updates the Contents Pane with any recent 
changes. 

Firearms 

New Firearm Opens Firearm Details to enter information for a 
new firearm (see Figure 60 – Firearm Details - 
Details Tab). 

Open Firearm 
Details 

Opens Firearm Details to view or modify details 
of the selected firearm. 

Delete Firearm Deletes the selected firearm. 

FIREARMS SEARCH VIEW 

The Firearms Search node, when selected, loads a view similar to Evidence Search and Case 
Search. You may search for firearms in any location by specifying the tag number. Even if the 
tag number has been updated, the search will still display the associated firearm, since the 
updates are tracked in the Tag History tab of Firearm Details. 

To search for a firearm: 

1) Click on the Firearms Collection module at the bottom of the Navigation Pane. 
2) Select the Firearms Search node at the top of the Navigation Pane. 
3) Enter the Tag # for which you wish to search.  
4) Click Search in the Contents Pane and any records associated with the entered Tag# 

will be displayed in the Firearms Search grid. 

FIREARM DETAILS 

One of the basic functions of the Firearms Collection module is to create and look up entries for 
firearms. In the Firearm Details screen, you may view the current information for an existing or 
destroyed firearm or create a new firearm entry. 

To create a new firearm entry: 

1) Select the Firearms Collection module at the bottom of the Navigation Pane. 
2) Click New Firearm from the Firearms grouping of the ribbon to open Firearm Details. 
3) Enter all available information. 

Note: Type, Description, Tag#, Manufacturer, Model, and either Caliber or Gauge 
are required, but “Unknown” is available for all drop-down lists in required fields. 
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4) Select Save and Close on the toolbar to enter the firearm and close Firearm Details. 

To access firearm details: 

1) Select the Firearms Collection module at the bottom of the Navigation Pane. 
2) Select a firearm entry from the Contents Pane. 
3) Click Open in the File grouping or Open Firearm Details in the Firearms grouping of the 

ribbon, or simply double-click the entry to open Firearm Details. 

DETAILS TAB 
The Details Tab of Firearm Details contains all of the general information about the selected 
firearm. 

 
Figure 60 – Firearm Details - Details Tab 

Table 34 – Firearm Details - Details Tab Field Descriptions 
Field Description 

Type Drop-down allows you to choose from a list of firearm types. 
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Field Description 

Description Drop-down allows you to choose from a list of firearm descriptions. 

Manufacturer Drop-down allows you to choose from a list of manufacturers. 

Model Drop-down allows you to choose from a list of firearm models. 

Caliber Drop-down allows you to choose from a list of caliber options 

Gauge Drop-down allows you to choose from a list of gauge options. 

Serial Number Enter the serial number from the firearm, if available. 

Tag Number Sequential number created to track the firearm entry in the system. 
Update… opens Manage Tag Number to change the assigned tag 
number. 

Donated By Text box allows you to enter a donor, if applicable. 

Date Donated Calendar allows you to choose date of firearm donation, if applicable. 

Lab Drop-down allows you to navigate to the lab or specific location within 
the lab where the firearm will be stored. Defaults to user’s current 
location. 

Room Text box allows you to specify a room within the location where the 
firearm will be stored. 

Comments Text box allows you to enter free-form comments concerning the entry. 

Image Right-click to browse to a location and load an image of the firearm. 

TAG HISTORY TAB 
The Tag History Tab of Firearm Details tracks any changes that have been made to the tag 
number assigned to a particular firearm. 
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Figure 61 – Firearms Details – Tag History Tab 

Table 35 – Firearm Details – Tag History Tab Column Heading Descriptions 
Column Heading Description 

Date Date on which the tag number’s update occurred. 

Tag Number Sequential number created to track the firearm entry in the system. 

Tag Status Status of the previous tag number. 

Comments Any comments related to the tag number. 

Active Checkbox indicating whether or not the associated firearm is active. 

DISPOSITION TAB 
The Disposition Tab of Firearm Details displays the parties involved and the date on which 
destruction of the firearm occurred, if applicable. 
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Figure 62 – Firearm Details – Disposition Tab 

Table 36 – Firearm Details – Disposition Tab Field Descriptions 
Field Description 

Destroyed By Identifies the employee who destroyed the firearm. 

Witnessed By Identifies the employee who witnessed destruction of the firearm.  

Date Destroyed Identifies the date on which the firearm was destroyed. 

EXPORTING FIREARM COLLECTION 

FA provides the ability to export information from the Firearms Collection to an external file in a 
variety of data formats. May also generate various types of printed output or import the Firearms 
Collection data to an external system using the exported file(s). Firearms collection information 
may be formatted for proper presentation. 

Resource Manager 
The Resource Manager module tracks information about interesting objects (e.g. Instruments, 
Supplies, Workstations, etc.). Resource Manager tracks structure, status, inventory and 
compliance and is a precursor to Quality Advantage. It also supports daily, operational data 
collection. Quality Advantage provides data aggregation, analysis, display and reporting. 
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Figure 63 – Resource Manager Module 

Table 37 – Supplies View Ribbon Options 
Grouping Option Effect 

File Open Opens Resource Instance Details for the 
selected resource instance. 

Content Refresh Updates the Contents Pane with any recent 
changes. 

Resources 

Add Supply 
Transaction 

Opens Supply Usage dialog to record the details 
of a supply transaction (see Appendix 61 – 
Supply Usage). 

Print Supply 
Requisition 

Opens dialog to select printer and format for 
printing a supply requisition report (see Appendix 
62 – Preview Supply Requisition Report). 

Export Print Data Opens Save As dialog to select a location and 
file name under which to save and export print 
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Grouping Option Effect 

data. 

RESOURCE INSTANCES 

Resource instances are created in the Resource Manager module and identify physical 
resources. 

Required data elements: 

 Id (InstanceNumberLabel) 
 Source (InstanceCreatedByLabel) 
 Date (InstanceDateLabel) 
 Description 

Examiners typically create a resource instance when receiving or preparing a resource. 
Resource Instances are checked for compliance with business rules at time of assignment. If an 
exam is performed significantly later than when the resource is assigned to the analysis form, 
the resource may not be valid at the time the exam is performed. 

FA walks the tree of resources and component instances, checking compliance of every item at 
every level. For example, if a workstation contains Acid Phosphatase Buffer that contains 
Sodium Acetate, FA checks rules for the workstation, Acid Phosphatase Buffer and Sodium 
Acetate when the workstation is assigned to the analysis form. 

To create a resource instance: 

1) In the Navigation Pane of the Resource Manager module, navigate to the desired Lab > 
Section > Resource Type > Resource Subtype > Resource. 

2) Click New in the File grouping of the ribbon or press CTRL+N to open Resource 
Instance Details (see Figure 64 – Resource Instance Details). 
Note: May need to update components and, if Track as Supply is checked, should 
enter a supply transaction to update inventory. 

3) Enter all available information in General Tab. 
4) Use ribbon options to add any resource actions or overrides. 
5) Click on the Product, Health and Safety Tab to enter any pertinent information. 
6) Click Save & Close in the ribbon when complete. 

RESOURCE INSTANCE DETAILS 
The Resource Instance Details screen shows the details of a lab resource by tracking the 
Actions, Components, Supply Usage, Needs Attention Overrides as well as the Product, Health 
and Safety.  
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Figure 64 – Resource Instance Details 

Table 38 - Resource Instance Details Ribbon Options 
Grouping Option Effect 

File 

Save and Close Saves the resource instance information and 
closes the form. 

Print Now Automatically sends information to the resource 
default printer using the default template. 

Print… Opens Print dialog with options for sending 
information to a printer. 

View 

Show Comments Toggles visibility of comments in the Action 
History and Supply Usage grids. 

Manage Files Opens Object Repository – [Instance] to add or 
view files related to the resource instance. 
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Grouping Option Effect 

Components 

Open Component Opens Resource Instance Details form for the 
selected component. 

Add Component Opens Select Components to select one or more 
resource instances to add as components to this 
one. 

Remove 
Component 

Removes the selected component(s) from this 
resource instance. 

Actions 

Add Action Opens New Resource Action … (see Appendix 
66 – New Resource Action) to select from a list of 
available actions assigned to the resource. 

Delete Action Deletes selected action in Action History Tab. 

Add Override Opens Needs Attention Action Override to add 
an override value, per action, changing how 
many days in advance this resource instance 
shows up in the Needs Attention View (see 
Appendix 67 – Needs Attention Action Override). 

Update Override Opens Needs Attention Action Override to modify 
the window value for the selected action. 

Delete Override Deletes the selected override. The value set for 
the resource/lab/section assignment will now be 
used to determine eligibility for the Needs 
Attention View. 

Add Supply 
Transaction 

Opens Supply Usage dialog to record the details 
of a supply transaction (see Appendix 61 – 
Supply Usage). 

Dev Save Report Data Saves report data to specified location. 

To add resource components: 

1) In the Navigation Pane of the Resource Manager module, navigate to the desired Lab > 
Section > Resource Type > Resource Subtype > Resource. 

2) Double click the appropriate resource instance in the Contents Pane or select Open 
from the File grouping of the ribbon to open Resource Instance Details. 

3) Click Add Components in the Components grouping of the ribbon to open Select 
Resources. 

4) Select from list of valid Resource Types (defined by administrator as Valid Components). 
5) Select from list of valid Resources to populate grid with any available resource 

instances. 
6) Select the appropriate resource instance and click Add to add to the list of components 

for the resource. 
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7) Repeat steps 4-6 for any additional components needed, then click Close to return to 
Resource Instance Details. 

To record activities: 

1) In the Navigation Pane of the Resource Manager module, navigate to the desired Lab > 
Section > Resource Type > Resource Subtype > Resource. 

2) Double click the appropriate resource instance in the Contents Pane or select Open 
from the File grouping of the ribbon to open Resource Instance Details. 

3) Click Add Action in the Actions grouping of the ribbon to open New Resource Action. 
4) Select Performed Action from list of actions (Required Action defined by administrator 

and assigned to the Resource). 
5) Select Date of Action – defaults to current date and time, but may be modified. 
6) Enter Performed By – defaults to current logged in user Id, but may be modified. 
7) Enter Comments – as appropriate for resource according to lab/section policy as well as 

any additional information. 
8) Click OK to save action and return to Resource Instance Details. 

To record a supply transaction: 

1) In the Navigation Pane, expand the appropriate Lab/Section and select the Supplies 
node. 

2) Select Add Supply Transaction from the Resources grouping of the ribbon to open 
Supply Usage (see Appendix 61 – Supply Usage). 

3) Select appropriate Action from list.  
4) Select Date and Time – defaults to current date and time, but may be modified. 
5) Enter Quantity of supply and select Agency, if needed. 
6) Enter Comments – as appropriate for the resource supply action according to 

Lab/Section policy. 
7) Click OK to enter supply transaction and close Supply Usage. 

Note: OK becomes active after all required fields are completed. 

MANAGE ANALYSIS FORM RESOURCES 

Analysis – Resources (see Appendix 26 – Analysis Resources) is accessible within analysis 
forms. Resources can be added or removed from an analysis form without having to close the 
form. For more information on analysis forms, see Analysis Form. 

To add resources in an analysis form: 

1) Select the Case Processing module at the bottom of the Navigation Pane. 
2) Select My Work folder at top of the Navigation Pane or expand (click on > to left of 

folder) user’s primary lab and section folders to select My Case Records folder.  
3) Double-click the appropriate case in the Contents Pane or select Case Record Details 

from the ribbon. 
4) Click on the Analysis Tab of Case Record Details. 
5) Select All Exams, Remaining Exams or, holding down the Ctrl key, select specific 

examinations. 
6) Right-click and select New Analysis of Type > [Analysis Form Name] to open the AUI.  
7) In the analysis form, click Resources in the Manage grouping of the ribbon to open 

Analysis – Resources (see Appendix 26 – Analysis Resources). 
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8) Go to Resources > Add Resources in the menu bar or click the Add Resources icon (

) on the toolbar to open Select Resources from [Lab Section]. 
9) Select the Lab/Section, Resource Type and Resource to auto populate the grid with all 

available resource instances. 
10) Select the resource instance needed, then click Add. 

Note: If instance has expired or has actions pending, FA will not permit use in the 
analysis form. 

11) Repeat steps 9-10 for any additional resources needed, then click Close. 
12) Click the red x in the upper right corner to close Analysis-Resources and return to the 

analysis form. 

To add resources in My Work View: 

1) Select the Case Processing module at the bottom of the Navigation Pane. 
2) Select My Work folder at top of the Navigation Pane or expand (click on > to left of 

folder) user’s primary lab and section folders to select My Case Records folder. 
3) Select one or more case records in the Contents Pane and click Add Resources in 

Analysis grouping of ribbon to open Worksheet Resource Assignment. 
4) Select one or more exam type entries in the grid and click Add Resource to open Select 

Resources from [Lab Section]. 
5) Select the Lab/Section, Resource Type and Resource to auto populate the grid with all 

available resource instances. 
6) Select the resource instance needed, then click Add. 

Note: If instance has expired or has actions pending, FA will not permit use in the 
analysis form. 

7) Repeat steps 4-6 for any additional resources, then click Close. 
8) Click the red x in the upper right corner to close Worksheet Resource Assignment. 

RESOURCE REPORTING 

The available views in the Resource Manager module combined with View options and print 
preview provide a variety of available report formats. Needs Attention View can be printed as a 
checklist for selected lab sections. Supplies View displays all resources with Track as Supply 
option checked. See Customizing Your Workspace for instructions on how to use filters and 
sorting to customize the grid data. Use the Print Preview option in the title bar to view the data 
and to access export and email options. 
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Figure 65 - Needs Attention Report 

To print Needs Attention View: 

1) Set scope of view using Lab / Section selections, then click Search. 
2) Click View Tab to use filters and grouping to select subset and organize view. 

3) Click Print Preview icon ( ) in title bar (see Figure 65 - Needs Attention Report) to open 
Preview. 

4) Use File menu or toolbar icons to email, print, or export data in specified file format. 
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Figure 66 - Supplies Report 

To print Supply Requisition Report: 

1) Click Supplies node under Lab Section node in Navigation Pane. 
2) Click Print Supply Requisition in Resources grouping of ribbon. 
3) Select from list of available templates 

Note: Customizable reporting available with Report Template Designer by FA 
administrator. 

4) Use File menu or toolbar icons to email, print, or export data in specified file format. 
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Appendix 

 
Appendix 1 – Forensic Advantage Settings 

 
Appendix 2 – Forensic Advantage Support 
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Appendix 3 – Custom AutoFilter 

 
Appendix 4 – Preview Grid Listing 
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Appendix 5 – Save Grid Settings 
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Appendix 6 – Load Grid Settings 

 
Appendix 7 – Reserve Lab # 
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Appendix 8 – Submission Label 

 
Appendix 9 – Submission Report 
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Appendix 10 – Search 

 

Appendix 11 – Import RFLE 
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Appendix 12 – Choose Officer 

 
Appendix 13 – Officer Information 



Forensic Advantage Systems  Forensic Laboratory User Guide 

Version 15.1  Page 123 of 165 

 
Appendix 14 – Add Exam 

 
Appendix 15 – Modify New Case Record 
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Appendix 16 – Person 
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Appendix 17 – Search Parties of Interest Tab 
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Appendix 18 – New Business 

 
Appendix 19 – Business Search 
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Appendix 20 – Create Evidence From Template 

 
Appendix 21 – Default Report Settings 
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Appendix 22 – Select Examiner 

 
Appendix 23 – Assign Evidence to Exams 
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Appendix 24 – Evidence Details 
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Appendix 25 – Add Multiple Evidence 
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Appendix 26 – Analysis Resources 

 
Appendix 27 – Activities 
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Appendix 28 – Case Record # – Parties of Interest 
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Appendix 29 – New Communication Log Entry 
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Appendix 30 – Review Management 

 
Appendix 31 – Analysis Results 
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Appendix 32 – Publish 
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Appendix 33 – Return Evidence 
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Appendix 34 – Select Evidence 

 
Appendix 35 – Select Resources 
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Appendix 36 – Edit – Image 
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Appendix 37 – Select – File 
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Appendix 38 – Select Values 
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Appendix 39 – Rich Text Editor 
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Appendix 40 – File Properties 
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Appendix 41 – Version History 
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Appendix 42 – Copy/Move Files 

 
Appendix 43 – Delete Terminate Case Record 
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Appendix 44 – Worksheet Resource Assignment 
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Appendix 45 – Transfer/Assign Case Records 
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Appendix 46 – Prepare Batch Processing File 



Forensic Advantage Systems  Forensic Laboratory User Guide 

Version 15.1  Page 148 of 165 

 
Appendix 47 – Import Batch Processing Results 

 
Appendix 48 – User Defined Evidence Description 



Forensic Advantage Systems  Forensic Laboratory User Guide 

Version 15.1  Page 149 of 165 

 
Appendix 49 – Select Employee to Copy 
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Appendix 50 - Chain of Custody Details View Menu 
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Appendix 51 – Add Evidence to Batch 
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Appendix 52 – Lockbox Transfer Request 
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Appendix 53 – Evidence Inventory 

 
Appendix 54 – Choose Batch Name 
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Appendix 55 – Accept Review 

 
Appendix 56 – Amended Report – Proceed? 
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Appendix 57 – Generate Report – AMENDED REPORT 

 
Appendix 58 – Add Author 
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Appendix 59 – Add Subject 

 
Appendix 60 – Move Resources 
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Appendix 61 – Supply Usage 

 
Appendix 62 – Preview Supply Requisition Report 
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Appendix 63 – Select Resource Types/Sub Types 

 
Appendix 64 – Resource Action Dialog 
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Appendix 65 – New Required Action 

 
Appendix 66 – New Resource Action 
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Appendix 67 – Needs Attention Action Override 


